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Introduction

This laboratory portion of Physics 50 has three primary objectives.

1. Reinforce concepts from lecture

2. Introduce the concept of uncertainty in measurements

3. Develop your ability to communicate technical data through written documents

You will be required to write a lab report for each experiment. Each report must properly
address the physics and measurement uncertainty involved in the experiment, and must be
written in an appropriate form for a scientific document. Your data and calculations for each
lab must be saved for inspection by your instructor (though you won’t necessarily include
all raw data in your lab reports). This manual contains descriptions of the physics involved
in each experiment, details of what is expected in a lab report, and an overview of error
analysis sufficient for writing complete lab reports. Please read the manual thoroughly, as it
will save you time in lab and when writing up your reports.

Much of the data analysis performed in this class will be done with the aid of “Logger
Pro”, a software package from Vernier. The software is installed on the lab computers, but
you can also download a copy for use on your personal machine from the following URL
http://tinyurl.com/sjsuLP or by making a copy of the installer which is saved on the
desktop of the lab computers. The installers require the password “property”. There are
step-by-step instructions in appendix C for most of the common tasks you will be doing with
logger pro.
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Lab Report Tutorial

Throughout this laboratory course you will write 12 lab reports (one for each of the 12 labs).
These reports will be written from scratch by hand or using a computer. This overview will
explain the key components of any lab report, and guide you in using the desired format.

Important: Each lab report your turn in must be in original (i.e. in your own words).
Copying phrases from your lab partner, any other student or the lab manual itself is plagia-
rism, and will not be tolerated, either at SJSU or in the real world. Infractions will result
in action at the university level, and may also lead to an F in your Physics 50 course.

General Lab Report Guidelines

Your imagined audience for these lab reports is a scientist in a different laboratory, using
different equipment. This scientist knows all of the physics concepts you are discussing, but
does not know the information about the particular experiment that is found in this lab
manual. Imagine that after reading your report, this scientist will attempt to reproduce
your results (using different equipment).

Be short and concise. Lab reports that are too wordy, or contain information outside the
scope of the required framework, will not be accepted (technical writing in the real world
must also be short and concise.)

Generic Lab Report Outline

Title Just use the title of the lab that week, include the Lab number.
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Background and Objective Describe the motivation for performing this experiment and
state the objective of your measurement. The objective is a clear statement of what is being
tested, that can be addressed in your conclusion

Measurement Section What system did you measure?

• Draw a labelled diagram (don’t copy from lab manual).

• Explain any terminology on your diagram(s).

• Give values for any fixed components on your diagram(s). Which physical quantities
of the system did you measure?

• Refer to the corresponding notation on the diagram.

• Do not explain how you made the measurement. Under what conditions did you make
the measurement(s)?

• Which parameters were varied? (Refer to diagram notation.) Where are the results of
your measurements?

• Refer to the data tables in the next section. If multiple systems were measured, make
it clear which table goes with which measurements.

Data Design easy-to-read and easy-to-interpret tables in which to enter your data and other
relevant parameters. Always use the appropriate number of significant figures for the entries
and include your estimate for the uncertainty. If there are other important parameters, list
them in this section.

• Measured values: Label the column appropriately (with correct units!).

• Other experimentally-controlled values with label and units.

• Calculated values with label and units. Also give the equation that you are using near
the top of the column; further explanation can go in the next section.

• Attach any graphs in this section (with titles, labeled axes, and correct units).

Analysis Give any equations that you are using (you don’t have to re-derive anything that
you’ve already been given.) Make sure that all of the parameters in these equations have
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been defined in the earlier sections, or define them here. If you have graphed any data, refer
to it here. If you used a curve fit on your data, explain how the parameters in the curve
fit can be interpreted using your equations. Compare your results to the expected results;
when appropriate, give a percent error (but NOT for each individual data point!).

Conclusion Answer any lab-specific questions not addressed in the Analysis section. Give
a one-sentence summary of your results (this will usually address the “lab objective” as
described in the lab manual

What does not need to be in the lab report

Save your valuable time by not including:

• How to use a particular piece of equipment. (Remember, your “audience” is a scientist
who is using different equipment.)

• How a particular measurement was made. (But you still need to say what was mea-
sured!)

• Needless repetition. Any time you are writing phrases that you’ve already written
elsewhere in the lab report, stop and think of a more concise way to summarize the
information.

• Re-derivations of equations derived or given in the lab manual.

• Problems that you encountered before taking your data.

More time-savers:

• Read the lab manual before class, so you know what you’ll be expected to do.

• If you are editing your report in a word processor and don’t know how to enter equations
or symbols, leave a blank space and draw them by hand on your hardcopy. These
reports do not have to look beautiful to be accepted.

• Don’t let yourself get bogged down on the same issue for more than 5-10 minutes
without asking your instructor for assistance.
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How NOT to save time:

• Don’t speed through your data-taking; there’s no surer way to forget to write something
down or make a mistake. Think about the results as you take the data; if they don’t
make sense, stop and try again. You don’t want to have to do it twice.

• Don’t copy text from the lab manual or your lab partner.

• Don’t ask your instructor to explain every step without first reading the manual and
trying to figure it out yourself.

Style

Beyond the content of the lab report, a well written lab report should adhere to a set of style
guidelines which include the following: The text of the report should not contain incomplete
sentences or other basic grammatical errors. The report should not be written in the first
person. Passive voice is preferred, as it puts the focus where it should be - on the experiment,
not the experimenter. Your description of the experiment should not contain the instructions
for completing the experiment or a detailed list of what you did, but only the relevant facts
critical to the procedure. Your lab instructor may have further comments on appropriate
style.

The two example lab reports in Appendix A show a poorly written report and a well written
report for a fictitious lab. Both use the same set of data and both are about the same
length. Compare and contrast these two reports. Which of these two reports more clearly
communicates the meaning and results of the lab? How many examples of bad style can you
find in the poorly written report?
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Experiment 1

Statistics

Objective

The objective of this laboratory is to see if there is a measurable difference between your
reaction time measured by catching a falling ruler with your right hand, versus catching it
with your left hand. A secondary objective is to give you experience in treating how errors
and uncertainties affect the outcome of an experiment.

Theory

All measured quantities have inherent uncertainty. By expressing the size of the uncer-
tainty in a measurement along with the measured value you can express the range of values
consistent with your measurement.

Consider the example of a bus driver who is asked how high his bus is. He might look at
the bus and state that it is 3 m high, however if you told him the bridge that he has to pass
under has a clearance of 3.1 m he might not be confident his bus will pass under. Why?
Because he knows that his statement that his truck is 3 m high was only a guess and has a
significant amount of uncertainty. If he were to give the keys to another driver at the end of
his shift and were to tell her “the bus is 3 m high” she might assume it is safe to drive under
the bridge with a clearance of 3.1 m. In common practice we’d use phrases like “the bus is
about 3 m high” or ”the bus is around 3 m high”, but in a scientific context, such general
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EXPERIMENT 1. STATISTICS

phrases are not useful - instead we express our uncertainty quantitatively (with numbers).
When pressed the bus driver might admit that his estimate that the bus is 3 m high is only
a guess, but he is confident it is less than 3.3 m high and that it is greater than 2.7 m high,
so he could say that the bus is between 2.7 m and 3.3 m high. Even better would be a
statement that he believes the bus is 3.0 m high with an uncertainty of ±0.3 m (i.e. between
3.0-0.3 m and 3.0+0.3 m). This is the proper way to report the result of a measurement in
scientific context.

In the previous example the bus driver didn’t actually measure the height of the bus. If he
had parked the bus in front of a tile building with tiles that he knew to be 0.3 m square
he might have been able to count the rows of tiles from the ground to the top of the bus
to determine the height of the bus. If he sees the bus is between 9 and 10 tiles high he can
state the height of the bus is 9.5 ± 0.5 tiles or 2.85 ± 0.15 m.

Figure 1.1: The bus is between 9 and 10 tile high

Note that the uncertainty has units, and should be given in the same units as the measure-
ment. He wouldn’t say the bus is 9.5 tiles ± 0.15 m because that is confusing to mix the units
like this. Even worse would be to say the bus is 9.5 ± 0.5 since now the units are ambiguous
(is it 9.5 tiles high or 9.5 m high? Is the uncertainty 0.5 tiles or 0.5 m?) If he had used a
tape measure, he would have more confidence in his knowledge of the bus height. Perhaps a
measurement with a tape measure reveals the bus to be a height of 2.905 m, however, when
he measures the bus again the following day he measures 2.901 m. Even though he is able to
read the tape measure accurately to the nearest mm, he is measuring a value that is 4 mm
different than the day before. The difference may be due to a change in the tire pressure, a
difference in the height of the ground where the bus wheels are compared to where the tape
measure is placed, or even changes in the length of the tape measure due to temperature
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EXPERIMENT 1. STATISTICS

changes. In any event, he can estimate the height of the bus more accurately than when he
was guessing, but cannot eliminate the uncertainty. In this case he could report the height
to be 2.903 m ± 0.002 m. While he could pursue the source of uncertainty further, it likely
is not necessary, since he can now feel confident driving under the bridge that is 3.1 m high.

The uncertainty in a measurement can be though of as a random error (and is often called
the measurement error). Statistically, random errors have an average value of zero, so if we
measure a quantity many times and average our results, the effect of the random errors is
reduced and the uncertainty associated with the measurement is improved. When a quantity
x is measured many times its average value x̄ is given by a statistical property of the data
called the mean, which is simply the average value. Specifically, if there are N measurements
for the quantity x, and we label them x1, x2, . . . xN the mean is:

x̄ =

∑N
i=1 xi
N

.

The spread of the data around this value represents the precision of the measurement and is
given by a different statistical property called the standard deviation, often denoted by the
greek letter σ (sigma):

σ =

√√√√ 1

N

N∑
i=1

(xi − x̄)2

The uncertainty in a single measurement, δx (δ is the lower case greek letter “delta”) and the
standard deviation of many measurements σ both represent the same thing – the precision of
the measurement (A physicist would be more likely to refer to δx since that is a property of
the measurement while a mathematician might refer to σ which is a result of the uncertainty
in the measurement that appears in the statistics of the data). In this experiment the
distinction between δ and σ is not particularly important. If a measurement is repeat many
times, the values can be averaged to give a more precise result, such that the uncertainty of
average value is found using Equation B.3 and is δx̄ = σ/

√
N .

To understand these properties it is often useful to construct a special type of graph called a
histogram that plots the number of times a value was measured to be within a certain range
as a function of the value. For example the histogram below shows the distribution of ages
for students in a class. For a normal distribution the mean is typically near the location of
the peak in the histogram, and the standard deviation describes the width of the peak (such
that 68% of the measured values fall within the peak, i.e. within one standard deviation
of the mean). Thus if a measurement is repeated many times the uncertainty in a single
measurement and and the standard deviation of the collection of measured values become
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equal. The uncertainty in a measured value is not determined by how close the
measurement is to some expected value.

Figure 1.2: Histogram showing the distribution of ages for students in a class

Often we have to calculate a quantity from a measured value (for example calculate the area
of a room from measurements of its length and width). When calculating a quantity from a
measured value the uncertainty in the measured value causes uncertainty in the calculated
quantity. To determine how the uncertainty in a measured quantity affects the uncertainty
in a calculated quantity we use calculus. If we measure a quantity x and wish to use it
to compute a value f(x) we can use the fact that the derivative df(x)

dx
gives the relationship

between a change δx, and the corresponding change δf , according to δf = df(x)
dx

δx, so letting
δx be the uncertainty in the measured quantity x, δf is the uncertainty in the calculated
quantity f(x). Appendix B described how the uncertainty in a value calculated from several
measured quantities is determined.
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Figure 1.3: Graphical representation of how uncertainty in x affects uncertainty in f(x)

Frequently we wish to measure the same quantity in two different ways to validate our mea-
surements, or we wish to compare our measured values to the measurements that others
have made. Because measurements have random errors we don’t expect multiple measure-
ments of the same quantity to give the exact same results, however, we can use some basic
statistical analysis to say how well they match. One common way to do that is to describe
how far apart two values are in units of the total measurement uncertainty, for example if
you measure the height of Alice to be halice = 154 ± 2 cm (that is a measured value of 154
cm with an uncertainty of 2 cm) and you wish to ask if she is the same height as Bob who
was measured to be 157± 2 cm you could say that their heights differ by 3 cm with a total
measurement uncertainty of 4 cm (There is 2 cm of uncertainty in Alice’s height and 2 cm
uncertainty in Bob’s height), which allows us to say that the difference in their heights was
measured to be 0.75× the total measurement uncertainty. Generally if two values differ by
less than 1× the total measurement uncertainty we say they “agree” with each other. In
this case the measured height of Alice and Bob agree (i.e. they are the same height), given
our measurement uncertainty – Alice could be anywhere from 152 cm to 156 cm, and Bob
could be from 155 cm to 159 cm, so the measurement doesn’t exclude the possibility that
they are the same height (for example they could both be 155.5 cm)
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Figure 1.4: The measured heights of Alice and Bob have ranges that overlap

Practice

Please complete the following questions before beginning the lab.

1. You drop 10 quarters and 10 nickels onto the floor and count the number of each that
land heads up. You repeat this process many times and come up with the following
results
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(a) Based on these histograms, how many times did 3 quarters land heads up?

(b) Based on these measurements do nickels and quarters have the same probability
of landing heads up?

2. Consider the expression for the height of an object as a function of time

y(t) = y0 + v0yt+
1

2
ayt

2

when moving with constant acceleration, where y0 is the initial position, v0y is the initial
velocity component in the y-direction, and ay is the acceleration in the y-direction.

(a) Derive an expression for the time it takes an object to fall to a height −y when
released from y0 = 0 while at rest with an acceleration of −g.

t =

(b) From our expression in part a, determine the derivative of t(y) with respect to y

dt

dy
=

(c) Using your expression from part b, what is the uncertainty in time δt that is
present when an object is measured to fall a distance y with an uncertainty of δy

δt =

Procedure

Measure your reaction time by having your lab partner drop a ruler while you try to catch
the ruler as soon as it is dropped. The distance the ruler has fallen will be recorded for
several attempts and used to calculate your reaction time. Repeat at least 20 times with
each hand.
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Analysis

1. Think about the uncertainty in your measurement of distance the ruler has fallen -
after catching it are you measuring to the top of your fingers, the bottom? How well
do you know the original position of the ruler?. Determine the minimum significant
distance that your measurement can resolve (i.e. 1 mm? 5 mm? 1 cm? 2 cm? etc. . .)
and round all values to the nearest measurement unit. Explain quantitatively the
factors that affect this uncertainty, such as the uncertainty in the initial position of
the ruler, the uncertainty in determining the position at which the ruler was caught,
the uncertainty in making measurements with the ruler, etc.

2. Enter your data into a spreadsheet (such as Excel, Numbers, or Google Docs). Find the
average and standard deviation for the data for each hand (for example by entering
into two empty cells “=AVERAGE(B1:B20)” and “=STDEVP(B1:B20)” to get the
average and standard deviation of the data in the first 20 rows of column B). Your
graphing calculator may also have the capability to calculate such statistics, or you
can always calculate the values by hand from the equations in the Theory section. If
the average falling distance is ȳ = 15.4 cm, and the standard deviation is δy=4.6 cm,
then you should state your result as y = 15.4± 4.6 cm. Include only significant figures
in your result. if you don’t know what significant figures mean, ask. Make sure to
include the correct units on your result and everywhere your measured value appears
in your lab report.

3. Create separate histograms for the data of the distance the ruler fell for each hand.

• The x-axis for each histogram should be 5 or 6 ranges of distance the ruler fell,
for example if the distances you measured range from 7-27 cm, you might choose
ranges of 5-10 cm, 10-15 cm, 15-20 cm, 20-25 cm, 25-30 cm, but don’t use the same
ranges as this example - choose your own to fully cover the values you measured.

• The y-axis of your histogram should be the number of data points that you
recorded that were within each range (or “bin”)

Label the axes of your histogram.

4. Draw a vertical line on your histogram representing the mean value of the distance the
ruler fell, as well as dashed vertical lines 1 standard deviation above and below this.
The range between the dashed lines represents your measured range. If you do this
correctly the number of trials falling within this range should be close to 68% of the
total number of trials.
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5. Calculate your (mean) reaction time (for each hand) based on the distance the ruler
fell along with the uncertainty in this value (from the standard deviation). You can
use the formulas you derived in part 2 of the prelab “Practice” section. Express your
reaction time in the form t = t̄ ± δt. Note the reaction time should be in seconds,
and must be calculated from the average distance the ruler fell. Does this value make
sense? If the value you got seems to big or too small, check you calculations and make
sure you didn’t use inconsistent units in the values you plugged into your formula.

6. Which hand had a faster reaction time. Is the difference significant in light of the
measurement uncertainty? If not you did not measure a significant difference int he
reaction time. Otherwise you did. State this result in the conclusion of your lab report.

Report

In addition to the standard elements of a well written lab report described in the introduction
to this manual, your report must include

1. An appropriate title

2. The objective of the lab

3. A description of the experiment being performed with any specific details that influence
the quality of your data.

4. The mean and standard deviation for the distance measurements

5. Your calculation of the reaction time (both the mean value and the uncertainty) based
on the distance measurements.

6. A summary of your results giving your average value for your reaction time along with
an uncertainty

7. A conclusion that addresses your stated objective, stating your measured reaction time
and answering the question “is your measured reaction time the same for both hands”.
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Experiment 2

Measurement and Precision

Objective

To determine the value of π from the ratio of the circumference to the diameter of a circle
while properly accounting for uncertainty.

Theory

It has been known since ancient times that the ratio of the circumference of a circle to its
diameter is equal to the transcendental number represented by π. That is,

π =
c

d

The instruments you use to measure this have a limit to their precision. You will have
to estimate to the nearest mark on the scale you use. As a general rule your uncertainty
in a measurement can never be less than ±1/2 of the smallest ruled increment on your
measurement tool, but can be (and often is) higher if there are larger sources of uncertainty
than those inherent in the measurement tool. For example if you have a watch that lacks
a second hand, then any measurements made with the watch will have to be rounded to
the nearest minute, and will have an uncertainty of ± 30s, although some things that you
measure with the watch might have a greater uncertainty, for example the amount of daylight
would be hard to measure to the nearest minute because the time the sun rises and sets is
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EXPERIMENT 2. MEASUREMENT AND PRECISION

difficult to determine so precisely. Can you think of another example of a measurement
where the uncertainty is greater than the precision of the measurement tool?

One method to estimate the precision of a measurement is to repeat the measurement several
times. When you measure a value several times and get slightly different results, you express
your measured value as x0 ± δx where x0 is the average value from your measurements and
δx is called the uncertainty and is half the deviation from the largest to smallest measured
values.

Note that the number of significant figures you include in your results is limited by the
number of significant figures in the least precise measurement in your data. Suppose you
measured the circumference to be c = 508 mm (which has 3 significant figures) and you
measured the diameter to be d = 148 mm (which also has 3 significant figures). According
to your calculator, the ratio c/d is equal to 3.432432432. This has 10 significant figures! You
must round off this answer to three significant figures and write c/d=3.43.

Numbers containing too many significant figures are wrong because they imply a precision
that is not justified by your measurements! For the same reason quantities calculated from
measured values that do not include the uncertainty are wrong. To reiterate, your final result
should never have more significant figures than your least-precise measurement, and should
always be written with the associated uncertainty.

While it is important to note the uncertainty in measured quantities, (such as the circum-
ference and diameter of a circle), it is also necessary to use those values to determine how
much uncertainty there is in any quantity calculated from those measurements (such as π).
There are two basic premises that govern how the uncertainty in measured quantities affects
the uncertainty in any calculated quantity, the first is that for a function f(a, b, c, . . .) the
uncertainty in the function f caused by the uncertainty in the measured quantity a is given
by

δfa =

(
∂f

∂a

)
δa,

with similar expressions for the uncertainty due to b, c, etc. The second premise is that if
the measured values a, b, c, etc. are uncorrelated the uncertainty in f from each adds in
quadrature as follows

(δf)2 = (δfa)
2 + (δfb)

2 + (δfc)
2 + . . .

while correlated uncertainties add directly (i.e. δf = δfa + δfb + δfc + . . .).

Measurements are uncorrelated when they are completely independent of each other. For
example consider a “measurement” of the sum of 2 dice that are rolled. If you had 4 dice and
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wished to perform this measurement you could roll the 4 dice twice and add up the values
for each die to get 4 uncorrelated measurements, or you could roll the 4 dice once and count
each value twice to get 4 correlated values.

Figure 2.1: Example of correlated and uncorrelated measurements

The randomness of the values of the dice ensure that, on average, the spread in values you
get with multiple rolls is less than when you only roll once and count the values multiple
times. The same principle applies to measurement uncertainty, as the equations above
show that uncorrelated uncertainties produce less spread in a measurement than correlated
uncertainties.

When the above two premises are applied to functions that involve the sum or difference
of two or more quantities, such as f(a, b, . . .) = a + b + . . . or f(a, b, . . .) = a− b− . . . the
resulting uncertainty in f due to each term is found from

δfa =
df

da
δa

δfb =
df

db
δb

where for f(a, b, . . .) = a± b+ . . . and df
da

= df
db

= ±1 with the sign depending on if b is being
added or subtracted. This gives δfa = δa and δfb = ±δb. When adding these uncorrelated
uncertainties using (δf)2 = (δfa)

2 + (δfb)
2 + . . . we get the general expression
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(δf)2 = (δa)2 + (δb)2 + . . . (2.1)

Sum and difference formula for uncertainty

If the function g(a, b, . . .) = a× b× . . . or g(a, b, . . .) = a/b . . . is the product or quotient of
two or more quantities the resulting uncertainty in g is found from

δga =
dg

da
δa

δgb =
dg

db
δb

where for g(a, b) = ab and dg
da

= b, dg
db

= a. This gives δga = bδa and δgb = aδb. When adding
these uncorrelated uncertainties using (δg)2 = (δga)

2 + (δgb)
2 we get

(δg)2 = (bδa)2 + (aδb)2

dividing on the left by g2 and on the right by (ab)2 (which we can do since g = ab and
generalizing for more factors gives the general expression(

δg

g

)2

=

(
δa

a

)2

+

(
δb

b

)2

+ . . . (2.2)

Product and quotient formula for uncertainty

If formula 2.1 is applied to the N measurements of the same quantity a, each with identical
uncertainty δa, the uncertainty in the average of those N results, ā,is reduced according to

δā =
δa√
N

(2.3)

Formula for uncertainty in an average

Note that the above expressions do not give the uncertainty δf directly, but rather are
written in a way that is easier to remember but requires that you solve the expressions for
δf to determine the uncertainty that you will quote in the calculated quantity. These rules
can be applied in turn on more complicated functions. For example the uncertainty in a
function that involves both the sum and product of measured quantities h(a, b, c) = a× b+ c
can be determined by first finding the uncertainty in the individual components, i.e. find
δg(a, b) for g(a, b) = a× b using formula (2) and then rewrite h as h(g, c) = g + c and apply
formula (1).
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Practice

Consider measurements of the width w and length l of a piece of paper used to calculated
the area of the paper using A = w × l.

1. If the length of the paper is measured twice using a ruler marked with 1mm increments,
and the measurements give values of l=298 mm and l=294 mm, what value should be
used for l? for δl? Express your answer in the form l ± δl

2. If the width of the paper is also measured twice using a ruler marked with 1mm incre-
ments to give a value of w=210 mm both times, what value should be used for w? for
δw? Express your answer in the form w ± δw

3. What is the area of the paper? What is the uncertainty in the area? Express your
answer in the form A± δA.

4. What is the value for the perimeter of the paper (p = 2l+2w)? What is the uncertainty
in this value? Express your answer in the form p± δp.

Procedure

Work in groups of two. Each student will measure the diameter and the circumference of
each provided plexiglas disk several times. The group results will be recorded in a table
similar to the one shown on the next page. Draw your own data table. Make sure it has a
descriptive title and contains units in the headers of the appropriate columns or after each
data value.
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Analysis

1. For each measurement of circumference (c) and diameter (d), determine the value of π
by taking the ratio c/d. Since both c and d have uncertainty in their measurements,
be careful not to quote more than the appropriate number of significant figures in your
value of π and to include the uncertainty in your result. To calculate the uncertainty
in c/d given your measured uncertainties in c and d you can use the rules given in
appendix B in the back of the lab manual

2. Determine your measured value of π by averaging the results from each disk. You will
have to use the formulas given in appendix B to determine the uncertainty in this value
given the calculated uncertainty in π measured for each disk.

3. Determine the percent difference between the average value of π you have calculated
and the accepted value of π=3.14159. . .

∣∣∣∣πmeasured − πacceptedπaccepted

∣∣∣∣× 100%

Your accepted value of π should only contain the same number of significant figures as
your calculated value.

4. Consider the possibility of a systematic error caused by the width of the string wrapped
around the circumference of the circle. Since the finite width causes the (center of the)
string to follow a circle of greater diameter than the outer edge of the plexiglas circle,
the measured circumference is likely for a larger circle than the measured diameter.
Would this systematic error cause the measured value of π to be too big or too small?
How can this systematic error be eliminated? (hint: how much greater is the distance
from the center of the circle to the center of the string than to the edge of the circle?).
Explain in your report the cause of this systematic error, and draw a diagram to
support your description. Correct the values for the circle diameters to account for
this error and recompute π.
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Example Data and Results Table

Disk # c (mm) d (mm) c/d

1 393± 8 124± 2 3.17± 0.08
2 625± 2 200± 1 3.13± 0.02
3 943± 3 290± 1 3.25± 0.02
4 1310± 10 410± 2 3.20± 0.03

In the first row in the example data table the calculated value of π is 3.17± 0.08 meaning,
within the experimental uncertainty a value as low as 3.09 or as high as 3.25 would be con-
sistent with our measurement, therefore this example measurement agrees with the accepted
value of π. If the experimental uncertainty were not included however, the values would not
agree since 3.17 6= 3.14. The calculated values for π in row 2 also agrees with theory, but
those in row 3 and 4 do not.

Report

In addition to the standard elements of a well written lab report described in the introduction
to this manual, your report must include

1. An appropriate title

2. The objective of the lab

3. The general procedure for the experiment

4. Your groups data in an appropriate format

5. An example calculation of your uncertainty in π for one of the disks

6. A description of any systematic errors present in the experiment and a discussion of
how they were dealt with.

7. A summary of your results giving your average value for π along with an uncertainty
with and without any systematic errors corrected for.

8. A conclusion that states if you met the objective of the lab (i.e. did your measured
value agree with the accepted value for π?)
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Experiment 3

Free Fall Analysis

Objective

The objective is to determine gravitational acceleration by studying the position of a falling
object as a function of time.

Theory

An object that is only acted on by gravity is said to be in free-fall. Near the surface of the
Earth the magnitude of acceleration due to gravity is given by g, and is nearly constant with
a measured value of 9.81 ± 0.02 (where the uncertainty comes from differences in elevation
at various points on the Earth’s surface as well as variations in the centripetal acceleration
for objects at different latitudes.) The acceleration is related to the velocity of an object
and the velocity is related to the displacement of an object through the definitions:

~a(t) ≡ d~v(t)

dt

and

~v(t) ≡ d~x(t)

dt
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so that an object moving in 1-dimension with constant acceleration has a displacement of
the form

y(t) = y0 + v0t+
1

2
at2

Since we have an expectation for the functional form of the measurements of the displacement
versus time, we can use a process called curve fitting to determine the parameters of the
function relating the measured quantities. In this case the initial position y0, initial velocity
v0 and the acceleration a are the parameters relating displacement to time. Knowing these
parameters would allow one to calculate the displacement ycalc(t) at any time and plot a
continuous curve. Because of uncertainty in measurements, however, the measured data
points would not be expected to lie exactly on this curve (although the range they include -
denoted by “error bars” should overlap the plot for 68% of the data).

When given a set of data points one can seek the parameters of the function that provide
the best matching of the calculated values to the measured values. Starting with some
initial guess as to the parameters of the function, one can (typically using a computer) vary
these parameters a small amount and calculate some measurement of how well the function
matches the data for each value of the parameters, choosing the parameters that give the
best match. This process is called curve fitting, and the method we will use to determine
how well a given calculated curve matches the experimental data is called the “least squares”
method. With this method, the error, δi, from the calculated value to the measured values
is computed for each data point according to

δi = yi − ycalc(ti)

where yi is the measured value and ycalc(ti) is the calculated value at ti. The “root mean
square error” is a measure of the average magnitude of the error, and for N data points is
given by

σrms =

√√√√ 1

N

N∑
i=1

δ2i

The root mean square error can be used as a measure of how well the curve fits the data. A
lower value for σrms means the curve is a better fit, and the measurement more precise.

The quality of a measurement can be expressed by its accuracy and its precision. Accuracy
is how close the measured value is to an accepted value and is often quantified by a percent
error ∣∣∣∣ameasured − aacceptedaaccepted

∣∣∣∣× 100%,
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while precision is how repeatable the measurement is, and is measured by the size of σrms
(which has the same units as the measured quantity.)

In choosing the parameters for a curve fit, we generally seek to create a curve that makes
the measured points as precise as possible (i.e. we try to minimize σrms). There are various
algorithms used to determine the parameters of the best fit line, but one of the most general
is a simple form of “trial and error”. While it would be possible, but tedious, to choose a
value for each parameter, manually calculate σrms for the resulting curve, and then repeat
with different values until you found the values that gave the most precise fit, this process
can be done quickly by computers, and many software tools exist that will easily do curve
fitting.

Practice

Consider the 4 sets of data shown below for v(t) the velocity of an object in freefall with the
corresponding linear curve fits. The slope of the best fit line gives the acceleration, and for
comparison a dashed line with a slope of −g is shown.

Figure 3.1: Example data
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1. Which data set, or sets has the best accuracy?

2. Which data set or sets has the best precision?

3. Consider just two data points such that v1=-12 m/s at t1=1 s, and v2=-19 m/s at t2=2
s. If the data is fit by a function v(t) = −(10m/s2)t what is σrms for this data? What
are the units?

Procedure

Your lab instructor will demonstrate how to record the motion of a falling object using the
tape timer.

1. Cut a 1.5-meter length of recording tape. Make a small loop in one end and seal it
with a piece of masking tape. Hang a load of between 500g and 1kg from the loop
(make sure to record the amount of mass that you use). The value you choose should
be different than that of your lab partner. Trim the tape so that the free end will pass
through the timer before the falling mass hits the floor.

2. Feed the other end of the tape up through the guides in the timer. Make sure the tape
runs between the carbon paper and the strike plate. Pull up the free end of the tape
until the falling mass is suspended just below the timer. The tape should be vertical
and aligned with the guide slots to minimize drag as it is pulled through the timer.

3. With the tape vertical and with the weight stationary, switch the timer on at its 40-Hz
pulse rate and release the tape. The timer will stamp spots on the tape giving the
position of the falling mass at 1

40
second intervals.
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Analysis

Look at your raw data; you will observe a track of spots on the paper tape. Since the
separation between the points gets larger, you can see that the speed of the falling mass is
increasing. If you don’t see an increasing separation between the first 20 or so dots, your
data is defective and you should repeat the experiment. To fit a quadratic curve to the data
we will use the software “Logger Pro” that is available on the lab machines. If you prefer to
work on your own machine, you may download a copy from http://tinyurl.com/sjsuLP

using the password “property” to install it.

1. Data: Pick a spot near the start of your data track and label it “point 1”. Start where
the separation between spots is about 1cm; if less, the distance increments cannot be
measured accurately. Label the spots consecutively: 1, 2, 3 . . .. Record the uncertainty
in the spot positions. Also record the value of the falling mass.

2. In Logger Pro enter your data for time and position into the cells in columns x and y
respectively.

3. Logger pro will automatically plot the data. If your plot does not look like figure 3.2
you may need to set the axes to “Autoscale from 0” by double clicking on the axis and
adjusting the “scaling” settings in the “Axes Options” tab of the pop-up window.

Figure 3.2: Logger Pro data and plot

4. Tell Logger Pro that you want to do a curve fit. From the “Analyze” menu select
“Curve Fit. . .”
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5. Select the functional form that you wish to fit. Initially we will assume the mass was
in freefall so that the displacement versus time is parabolic. Select “Axˆ2+Bx+C
(Quadratic)” as the function that describes this model.

6. Estimate the free parameters. If the curve fit has the form y = Ax2+Bx+C, and your
model for the trajectory of the object has the form y(t) = y0 + v0 + 1

2
gt2, determine

what the values of A, B, C and x are in terms of the quantities y0, v0, g and t.

7. Try out your expected parameters. Select “Manual” from the options for “Fit Type”
in the curve fitting window and type in values for A, B, and C based on the values
that you expect y0, v0 and g should be. Record the value of the root mean square error
(RMSE) determined by Logger Pro and shown at the bottom of the coefficients window.
This describes the distance (in the vertical direction) of a typical data point from the
curve with the parameters you entered. Observe the plot of this curve superimposed
on your data. Try modifying the parameters by hand to see if you can make the curve
fit better. You will be able to see if the curve fits better both qualitatively by looking
at the plot with the curve on it, and quantitatively by the size of the RMS error (which
will be smaller for a better fit). Give an example of how you reduced the RMS error
by changing the estimates for A and/or B. What does this tell you about your initial
estimates for the initial position and initial velocity?

8. Let Logger Pro find a better fit. Select “Automatic” from the options for “Fit Type”
in the curve fitting window and click the “Try Fit” button. Record the fit parameters
A, B, and C as well as their uncertainties and the root mean square error σrse for this
fit.

9. Print the graph of your data with the best fit curve superimposed

10. Record the values and uncertainty of y0, v0, g corresponding to best fit parameters A,
B, and C. Write these on the graph and include them in your lab report.

11. Comparison to measured values: How far is your measured value for the acceleration
from the accepted value of g? Does your measured value agree with the accepted value?

12. How does the uncertainty you determined in step 3a compare to the observed standard
deviation σrse? If you have estimated the uncertainty properly they should be similar
in magnitude. If they are not it suggest an error in your original estimation of the
uncertainty in the position measurements.

13. If (and only if) your result (taking uncertainty into consideration) differs from the
accepted value of g, discuss (as quantitatively as possible) whether friction or air re-
sistance might account for the difference. You might discuss any difference between
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your results and your partners results which were based on a different amount of falling
mass as evidence for or against friction or air resistance accounting for any inaccuracy
of your result.

Save your work onto your flash drive or your own laptop to keep until the end of the semester.
You may need it later and files left on the lab computers will be deleted.

Report

In addition to the standard elements of a well written lab report described in the introduction
to this manual, your report must include:

1. An appropriate title.

2. The objective (One or two sentences).

3. Graph of displacement versus time including the best fit line.

4. A conclusion that addresses the questions asked in step 3k and 3l of the analysis section.
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Experiment 4

Newton’s Laws

Objective

To demonstrate and confirm Newton’s 3 laws of motion and to test the equivalence principle
relating inertial mass to gravitational mass.

Theory

The field of Classical Mechanics is based on Newton’s 3 laws of motion, that can be summa-
rized as follows:

1. An object at rest will remain at rest unless acted on by a net force, and an object in
motion will continue in motion with constant velocity unless acted on by a net force.

2. The net force on an object is equal to the time rate of change of its momentum. (i.e.
~F = m~a for an object with constant mass).

3. For every action (Force) there is an equal and opposite reaction.

Newton’s first law is really just a specific case of his second law. Newton’s second law states
that the net force on an object equals its mass times its acceleration. With this relationship
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we can say that the mass of an object is a constant of proportionality between the force
applied on the object and its acceleration - we will call the mass found this way the “inertial
mass”, as opposed to the “gravitational mass” that is found from the objects weight. The
equivalence principle tells us that these two definitions of mass are equivalent, and results in
objects having the same acceleration due to gravity, regardless of their weight. In this lab we
will determine the mass of an object by measuring the net force on it and its acceleration.
This measured mass will then be compared to the mass found from its weight.

In this experiment, the test object will be suspended by a string from a force sensor and the
object will be accelerated in the vertical direction. That means there will be two forces on the
object, its weight W and the tension in the string T which is measured by the force sensor.
The acceleration of the object will be determined by measuring the angular acceleration of
a pulley that the string passes over using a digital rotation sensor. The linear acceleration
of the string a as well as the test object that it connects to will be related to the angular
acceleration α of the pulley of radius r by a = αr. Newton’s 2nd law applied to the hanging
mass is

T −W = ma

which can be written in the form

T = W +ma

Allowing us to fit a line to our data and relate the slope of the line to m and the y-intercept
to W .

Newton’s third law will be tested by connecting two force sensors together and measuring
the force on each independently as various forces are applied by one sensor on the other

Practice

Consider a test object with a weight of 2.00 N, attached to a string (as described in the
“Theory” section) with a tension of 2.10 N that passes over an ideal pulley of radius 2.50
cm.

1. What is the magnitude of the net force on the object?
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2. If the pulley has an angular acceleration of 19.7 rad/s2 what is the magnitude of the
linear acceleration of the test object?

3. What is the measured inertial mass of the test object?

4. What is the gravitational mass of the test object?

Procedure

First we will test the statement from Newton’s first law that an object at rest will stay at
rest unless acted on by a net force.

1. Choose a mass between 100g and 500 g and place it on the table so that it is stationary
with no net force acting on it.

2. Observe the motion (or lack thereof) of the object.

3. Repeat several times

Now we will investigate Newton’s 2nd law

1. Measure the radius of the arc the string will take as it passes over the pulley on the
rotation sensor. As in the lab where you calculated π you should add the radius of the
string to the radius of the pulley to avoid a systematic error due to the finite string
width. Make sure to record an estimate of your uncertainty in this value.

2. Make sure the LabQuest data logger is turned on, the digital rotation sensor and the
force sensor are plugged in and the unit is reading an angle and force.
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3. If the data logger is not reading a force it may need to be configured to use the force
sensor: From the tab, select “Sensor setup. . .” choose “Force” for whichever channel
the sensor is plugged into and then from the submenu select “Dual Range Force 10N”
and click “OK”.

4. Determine the weight of the hook on the end of the force sensor. Hold the sensor
vertically with the hook pointed down and record the reported force. Flip the sensor
upside down so the hook points upwards and again record the measured force (it should
be negative). The difference in these measurements is twice the weight of the hook
Whook. .

5. With nothing connected to the hook of the force sensor, hold it horizontally (with the
hook on the side) and observe the measured force on the handheld data logger. If the
force is not zero it needs to be zeroed using the following step.

6. Zero your force sensor. While holding the sensor horizontally (with the hook on the
side), go to the tab, select Sensor→Zero→Dual Range Force ±10 N.

7. Estimate the uncertainty in the force readings from the force sensor by observing the
fluctuations in the reading while the sensor is at rest.

8. Place between 200g and 500g of mass onto the end of a string. Connect the other end
of the string to the hook on the force sensor and mount the force sensor on a cart on
a spring. Pass the string 90o around the pulley so that the side connected to the force
sensor is horizontal and the side connected to the mass is vertical.

9. Pull the cart all the way to the end of the track and make sure the hanging mass
is stationary and not swinging back-and-forth. Click on the data logger device
to start recording data and release the cart allowing it to move in and out to raise
and lower the mass for 10 seconds while the LabQuest data logger collects force and
acceleration data.

10. Transfer the collected data onto one of the lab computers for analysis by connecting
it via a USB cable and opening “Data Logger Pro” on the computer. The device will
be auto-detected and you will be prompted to import the data. If you are successful
you can skip step 3k, otherwise see the instructions for manually importing data in the
next step.

11. If your data did not import automatically, save your data on the handheld device by
selecting “save” from the “file” menu. Then when it is connected to the computer,
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select “LabQuest Browser” from Logger Pro’s “File” menu and select the file that you
just saved.

Finally we will investigate Newton’s 3rd law of motion. This will require borrowing a force
sensor from another lab group, but the measurement is quick so you can likely find a way to
share resources without introducing delays

1. Plug two force sensors into the back of your LabQuest data logger (and disconnect the
rotation sensor if it is still connected) and select . You should see readings for
both force sensors. If you do not, power off the data logger and power it back on to
get it to recognize both force sensors.

2. Zero your force sensors. With the sensors placed horizontally on the table (with the
hook on the side), go to the tab, select Sensor→Zero→Dual Range Force ±10
N. Do this procedure for both sensors.

3. Connect the hooks on the end of the sensors together. Work with a lab partner so that
you are each holding one of the force sensors.

4. Click on the data logger device to start recording data and begin to pull gently
on the force sensor. Try to coordinate with your lab partner so that one of you pulls
harder than the other. If your sensor saturated (exceeds the maximum value of 10N)
you will see a “plateau” on your graph of force versus time. In this region of the graph
accurate data was not recorded. If you have this in your data repeat the experiment
using less force.

5. Again, transfer the data to Logger Pro on the computer. If you haven’t yet analyzed
the data from the experiment on the Second law, you might save that or complete the
analysis on it first so that you do not have problems if you overwrite the data with the
newly imported data.

Analysis

Import your data from the experiment on Newton’s second law, or open the file containing
this data. The data table in Logger Pro will have columns for (among other things) total
Force and angular acceleration. We will need to create a “calculated column” for the linear
acceleration. We will then plot force versus acceleration and perform a linear curve fit to
determine the weight and the inertial mass of our object
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1. Create a column for the linear acceleration by clicking “New calculated column. . .” from
the “Data” menu. Give the new column an appropriate name (in both the “Name:”
field and the “Short Name:” field). In the equation panel create an expression for
this column of the form r ∗ α where r is the measured radius of the pulley that the
string passed over, and α is the column for angular acceleration (which by default is
incorrectly called “Acceleration”)

2. When Logger Pro imported your data it created some graphs of the measured functions
versus time. Delete all but one of these. The remaining one we will change to plot
what we are interested in: force versus linear acceleration.

(a) Click on the label of the Y-axis on the graph you wish to modify. From the pop-up
menu select the “Force” column.

(b) Click on the label of the X-axis on the graph you wish to modify. From the pop-up
menu select the “linear acceleration” column.

(c) Right click on each of the axes and select “Autoscale” to have Logger Pro set the
scale so that your data fills the graph.

(d) Perform a linear fit to the data by choosing “Linear Fit” from the “Analyze”
menu. The parameters of the fit will be shown on the graph.

(e) If your graph has a negative slope it simply means the rotation sensor and force
sensor were oriented with their “positive” directions opposing. If this is the case
you can fix this by explicitly including a negative sign in your equation for the
linear acceleration column (double click the column header to edit the equation).

3. The y-intercept of the fit gives the force applied when the object is not accelerating,
which is the weight of the hanging object. Record this value as the hanging weight
Whanging, and calculate the total gravitational mass from this weight and the weight of
the hook calculated in step 3d as mg = (Whanging +Whook)/g.

4. Note the slope of the linear fit, this is the inertial mass of the hanging mass and the
hook (both of which were being accelerated). Record this value as the inertial mass
mi.

5. Uncertainty: If the box showing the parameters of the fit does not show the uncertainty
in the parameters, double click it and select the “show uncertainty” checkbox. Record
the uncertainty in the y-intercept parameters as δWhanging.

6. Find the uncertainty in the gravitational mass of the object. First use the sum/difference
rule for uncertainty to find the uncertainty in the total weight W = Whanging + Whook
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from the uncertainty in the hanging weight δWhanging and the uncertainty in the weight
of the hook δWhook From your uncertainty in total weight, δW and the relationship
mg = W/g use the product/quotient rule to get the uncertainty in the gravitational
mass δmg assuming the uncertainty in g is zero.

7. Find the uncertainty in the inertial mass of the object. The uncertainty in the slope
δmi (and therefor in the inertial mass) will be dominated by the uncertainty in r with
a magnitude of δmi = mi

δr
r

.

8. Did your inertial mass and gravitational mass agree within their uncertainty?

You will now analyze the data from the experiment on Newton’s third law. Open the file
containing the data for this experiment in Logger Pro, or import the data from the LabQuest
data logger if you haven’t already done so.

9. Because the force sensors were oriented anti-parallel to each other, they each have a
different direction for what was recorded as a positive force. To fix this we will invert
the sign of the data from force sensor 2 and call that value F ′2. Create a new calculated
column with an appropriate name and enter an expression of the form −F2

10. Create a column for the force difference by choosing “New calculated column. . .” from
the “Data” menu. Give the new column an appropriate name (in both the “Name:”
field and the “Short Name:” field) and enter an equation of the form ∆F = F1 − F2

to get the difference in forces measured by each force sensor.

11. Create a graph of force versus time showing the force from each sensor F1, F
′
2 and the

difference ∆F .

12. Find the mean and standard deviation of the force difference by selecting “Statistics”
from the “Analyze” menu.

13. Is the force difference ∆F equal to zero within the uncertainty?

Save your work onto your flash drive or your own laptop to keep until the end of the semester.
You may need it later and files left on the lab computers will be deleted.
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Report

In addition to the standard elements of a well written lab report described in the introduction
to this manual, your report must include:

1. Your plot of applied force versus acceleration, showing the best fit line.

2. For Newton’s third law experiment, your plot of the two forces and their difference
versus time
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Experiment 5

Vector Addition

Objective

To add vectors graphically, analytically, and experimentally (using the force table).

Theory

Vectors are quantities with magnitude and direction, such as force, displacement and veloc-
ity. They can be represented graphically by arrows that have a length proportional to the
magnitude of the physical quantity they represent and the same direction. When vectors
quantities are added care must be taken not to simply add the magnitudes of the quantities,
but to add the vectors taking into account their direction. For example if you drive 4 km
north-east and then 3 km north-west you do not end up 7 miles from where you started, but
rather 5 miles in a direction mostly north. In this example displacement vectors were being
added. There are two general methods for adding vectors: adding their components, and
adding graphically.
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Figure 5.1: (left) Vector components and (right) graphical addition of vectors

Adding vector components requires that you know the magnitude of the vectors’ components.
In the preceding example the first vectors being added has components of 2.8 km in both
the north and east direction (corresponding to Ax and Ay in the left hand figure), while
the second had components of 2.1 km north and -2.1 km east. Thus the sum of these
displacements has components of 2.8 km+2.1 km=4.9 km north and 2.8 km-2.1 km=0.7 km
east.

To find the sum of two (or more) vectors graphically the vectors being added should be lined
up tip-to-tail. The sum is then the vector from the tail of the first to the tip of the last (the
dashed vector in the right hand figure).
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Practice

Consider two vectors, vector A has a magnitude of 3 cm and at an angle of 350, while vector
B has a magnitude of 2 cm and points at 1500.

1. Use a protractor and ruler to draw each vector, first separately, then tip-to-tail.

2. From your scale drawings, estimate the following values:

Ax = Ay = Bx = By =

For ~A+ ~B, Magnitude= Angle=

Procedure

The force table will be demonstrated by your instructor. Set up 2 forces of unequal magnitude
using masses between 0.20 kg and 0.50 kg separated by an angle between 40o and 70o. Find
the balancing force, ~Fb , on the force table and the amount you can deviate the angle δθ
and the weight δFb of the balancing force and maintain equilibrium. Record your values in
a data table
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1. Choose an appropriate scale for your diagram which will allow your diagram to be
large yet fit on a single page. Then add your two original vectors using the tip-to-
tail method as illustrated below. Since the balancing force ~Fb has an uncertainty in
magnitude δFb and angle δθ you should draw an ellipse around the tip of vector ~Fb
indicating the region of uncertainty. Within your experimental uncertainty, is the
length of the vector sum of the forces ~F1 + ~F2 equal to the length of the balancing force
vector, ~Fb, and oppositely directed to it? What is the percent error in the magnitude
of the ~Fb compared to the magnitude of ~F1 + ~F2

2. Draw a new scale diagram of the vectors with the same scale factor as in step 3a,
but this time draw all of the vectors separately (i.e. don’t draw them tip-to-tail) and
draw the x- and y-components of each vector. Measure the length of the vector com-
ponents. Since vector ~Fb has uncertainty the components must have a corresponding
uncertainty as well. Record the component values in your data table and add up the
vector components numerically. Is F1x + F2x = −Fbx within the uncertainty δFbx? Is
F1y + F2y = −Fby within the uncertainty δFby?

Figure 5.2: Force table setup and corresponding vector diagrams
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Report

In addition to the standard elements of a well written lab report described in the introduction
to this manual, your report must include:

1. Your two full page vector diagrams

2. The completed data table

3. The percent error you determine in step 3a

4. Were your sum vectors and balancing vectors equal and opposite, within the experi-
mental uncertainty?

Data Table

Name Angle Mass Magnitude of Force Vector Length x-component y-component
θ m mg Fx Fy

~F1

~F2

~F1 + ~F2 XX XX
~Fb

Scale factor
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Experiment 6

Centripetal Force

Objective

The objective of this lab is to verify that centripetal force is equal to mv2

r

Theory

The magnitude of centripetal force on an object moving with speed v in circular motion with
radius r is given by

Fc = m
v2

r

This is frequently written in terms of the angular velocity, ω of the object, rather than its
linear velocity. From the definition of an angle θ measured in radians,

θ =
s

r

in terms of the arc length s that it traces out at a distance of r we can take the time derivative
of both sides to get the magnitude of the angular velocity ω ≡ dθ/dt so that

ω =
dθ

dt
=
ds/dt

r
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recognizing ds/dt as the magnitude of linear velocity, we get the relation ω = v/r which we
can use to express the centripetal force as

Fc = mω2r

The validity of this relationship will be tested by simultaneously measuring the angular
velocity ω and centripetal force Fc on a mass rotating in a circular trajectory with a radius
of r.

Procedure

A force sensor is set up to measure the force pulling on a mass that is moving in circular
motion. The force sensor is mounted on a rotation sensor so that the force and angular
velocity can be simultaneously recorded by the LabQuest Data Logger as the whole system
is rotated around the axis of the rotation sensor.

1. With the apparatus completely at rest and with the LabQuest Data Logger in the
tab, tap the Sensors menu, select Zero and then select Dual Range Force Sensor to
calibrate the force sensor.

2. Press the button on the LabQuest data logger to begin recording data, then twist
the apparatus a half turn and release it so that is spins back and forth several times
while the the data logger collects data. If the peak magnitude of your data is less that
0.5 N repeat the measurement using a larger amplitude of rotation (i.e. pull it back
further), a tighter (or additional) rubber band or using a larger mass.

3. Rotate the apparatus so that the mass hangs vertically and is stationery. Record the
weight of the mass from the force readout on the data logger W and the uncertainty
δW .

4. Determine the radial position of the center of mass rcm. The mass on the force sensor
can be treated as two pieces. One piece is internal to the force sensor (mostly the
attachment rod that the external mass screws into) with a mass of mint = 8 ± 2 g,
while the remainder is the external mass that has been screwed on. Do not attempt
to separate the external mass to weight it or the internal mass - as this can result in
small parts to the force sensor falling off and getting lost. The center of mass of the
total is given by

rcm =
rintmint + rextmext

mtotal
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You can determine mtotal from the weight you recorded in step 3c, the position rext can
be measured from the axis of rotation to the geometric center of the disk, but rint and
its associated uncertainty must be estimated (the uncertainty is bounded by the size
of the force sensor box!).

Analysis

We will plot the measured centripetal force Fc versus the measured values of mω2r, while
keeping in mind that there may be two types of errors present in the data: Systematic error
which affects all of our calculated values the same (for example due to an error in measuring
rcm) and random error due to the intrinsic noise of the sensors we are using.

1. Transfer the collected data onto one of the lab computers for analysis by connecting it
via a USB cable and opening “Data Logger Pro” on the computer. The device will be
auto-detected and you will be prompted to import the most recent data set. Delete all
of the graphs that were automatically generated when importing your data - we won’t
need them.

2. Create parameters for the measured quantities rcm, W and for the acceleration due to
gravity g = 9.80 m/s2 that we will use later. Select “User parameters. . .” from the
“Data” menu, and add a parameter for each quantity giving each an appropriate name
and recording the numerical value (in SI units).

3. Insert a column to hold the calculated value of the centripetal force on the mass.
From the “Data” menu select “New Calculated Column. . .” and give the column an
appropriate name (and short name) and then enter a formula of the form (W/g)ω2rcm
where ω is accessed from the “variables” drop-down list (the column incorrectly labeled
“Velocity”). The other quantitates are accessed from the “parameters” drop down list.

4. Uncertainty in m. The dual range force sensor has a sensitivity of 0.01 N (when set to
a range of 10 N). Taking this as the uncertainty in the weight of the mass, determine
the uncertainty in its mass.

5. Uncertainty in ω: The rotary motion sensor has a sensitivity of 1 degree. Using the
time interval ∆t between successive data points (which you can determine from the
data column) calculate the uncertainty in ω, δω = δ(∆θ)/∆t. Make sure to convert to
rad/s.
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6. Uncertainty in rcm. Use the general expression for the center of mass of two objects
rcm = rintmint+rextmext

mtotal
and the product/quotient rule and sum/difference rule for error

propagation to estimate the uncertainty in rcm.

7. Create parameters for the measured and calculated uncertainties δm, δω and δr.

8. Create an uncertainty column. Using the product/quotient rule for uncertainty prop-
agation, determine the formula for the uncertainty in the calculated centripetal force
mω2r in terms of the uncertainties δm, δω and δr. Enter this into a new calculated
column, the uncertainty in the calculated centripetal force.

9. Create a graph of the measured centripetal force Fc versus the calculated value mω2r.
From the “Insert” menu select “Graph” and set the x-axis to be the measured cen-
tripetal force Fc and the y-axis to be the calculated centripetal force mω2r

10. Error bars. We can express the uncertainty in our data points by including error bars
on the plot. These vertical and/or horizontal bars around the data points represent the
range of y and/or x values respectively that are within the experimental uncertainty
associated with the measured data point.

(a) Click on the heading of the column for the measured centripetal force. In the
“Options” tab, check the “error bar calculations” box and enter a fixed value
error or ±0.01N which represents the sensitivity limit of the force sensor

(b) Repeat the previous step for the column for the calculated centripetal force, but
this time instead of entering a fixed value for the uncertainty, tell it to use the
column created in step 3h

(c) Double click on the graph to bring up the graph options window and turn on the
option to show the x and y error bars and turn off the option to connect the data
points with lines.

11. Fit a curve to your data by selecting “Curve Fit. . .” from the “Analyze” menu. Choose
“Linear” as the general equation, enter “1” as the value for the parameter A, the slope
of the curve, and click OK. This line represents the expression Fc = mω2r

12. What percentage of your data points agree with the line (i.e. what percentage of
the error bars does the line pass through? If all of the uncertainties were estimated
properly and there are no systematic errors unaccounted for, 68% of the data points
should fall within one error bar of the curve.
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13. Fit another curve to your data by selecting “Curve Fit. . .” from the “Analyze” menu.
Again choose “Linear” as the general equation, but this time select “try fit” to have
Logger Pro find the slope of the line that best fits the data. Record the slope of this
line.

14. What is the percent difference between the measured slope of your line and the the-
oretical value of 1? If more than 68% of your data points lie within one error bar of
the slope=1 line, then the difference is not significant. Was the deviation from the
expected value that you observed significant?

Save your work onto your flash drive or your own laptop to keep until the end of the semester.
You may need it later and files left on the lab computers will be deleted.

Report

In addition to the standard elements of a well written lab report described in the introduction
to this manual, your report must include:

1. A discussion of the magnitude and likely origin of any systematic errors in your mea-
surement.

2. The graph of Fc versus mω2r.

45



EXPERIMENT 6. CENTRIPETAL FORCE

46



Experiment 7

Friction

Objective

To verify that the force of static friction obeys fs ≤ µsN and the force of kinetic friction
obeys fk = µkN where µs ≥ µk and are independent of the area of contact.

Theory

Friction is a contact force that opposes the motion of objects. For objects that are stationary
relative to each other the force of static friction between them has a magnitude that obeys
fs ≤ µsN , where N is the normal force between the objects and µs is called the coefficient of
static friction, a constant that depends on the materials in contact. If you were to gradually
push harder-and-harder on an object sitting on a surface with friction, the force of friction
would increase to oppose your applied force, rising to the maximum value fs,max = µsN
before being overwhelmed by the applied force, at which point the block would begin to
slide and kinetic friction with a magnitude of fk = µkN would oppose the motion. Since
the kinetic friction is not strong enough to prevent the motion it cannot be greater than the
maximum force of static friction. According to these relationship the force of friction does
not depend on the area in contact, only the materials. These relationships will be tested in
this lab.
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Practice

Figure 7.1: Magnitude of friction force as a function of time as a force is applied

Identify and label on the above plot the maximum value of static friction (fs,max) and the
force of kinetic friction (fk).

Procedure

A block, loaded with various masses will be set on a piece of paper which is pulled out from
under it, while the block is restrained by a “force sensor” with the data logged for later
analysis to determine µs and µk between the block and the paper. In these experiments the
block will sit on three of its four surface, a large wooden surface, a small wooden surface,
and a large felt surface.

1. Tape a long piece of paper on top of a sheet of plexiglass with the wood block on top
of the paper near one end. Position the plexiglass so that its edge hangs off the edge
of the lab table.

2. With the force sensor range set to ±10 N, connect it to the wooden block by a string
tied to the force sensor on one end and the wooden block on the other. Plug it into
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the data logger unit. The sensor should be immediately recognized and the LabQuest
display updated with a reading of the current value form the sensor If so you may skip
to step 3d.

3. Configure LabQuest to use the force sensor. From the tab, select “Sensor setup. . .”
choose “Force” for whichever channel the sensor is plugged into and then from the
submenu select “Dual Range Force 10N” and click “OK”.

4. Calibrate your force sensor. With no tension in the string between the force sensor
and the block, go to the tab, select Sensor→Zero→Dual Range Force ±10 N.

5. Practice data collection by having your lab partner press down on the force sensor to
hold it in position while you gently pull the paper and plexiglass together horizontally
out from under the block, slowly increasing the applied force until they slide out.

6. Once you are comfortable with the previous step, click on the data logger device
to begin recording data and repeat step 3e for a 10 second interval. Your data should
resemble figure 7.1.

7. Record the relevant values for the frictional force from the force vs. time curve on the
data logger:

(a) Using the stylus, tap the peak of the curve (Note that unlike today’s smart phones,
this touch sensitive display requires a moderate amount of pressure), use the
arrow keys to fine tune the point you have selected until the readout displays the
maximum force. Record this value as the maximum force of static friction, fs,max.

(b) Using the stylus, tap and drag over the “flat” region of the graph (where the block
was moving with constant velocity) to highlight it. Select Analysis→Statistics

from the drop down menus to measure the mean value and standard deviation of
the force of kinetic friction, fk. Record these values.

(c) Record any other parameters relevant for this trial, such as the value of any masses
that were placed on top of the sliding block.

8. Repeat the measurement (steps 3f and 3g) one more time to get an average value and a
spread (uncertainty) in fs,max. Note that unlike the maximum value of static friction,
the value of kinetic friction is represented by many data points in each experiment, so
average and spread in values of fk can be obtained from a single experiment.

9. Place a 500 g mass on top of the cart and repeat the measurement 2 more times.
Finally with two 500 g weights on the block repeat the measurement 2 more times.
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10. Repeat the above procedure testing different surfaces of the block: the large and small
wooden surfaces and the large felt surface in contact with the paper for one set of
measurements.

Analysis

Enter your data into logger pro (you could also use Excel if you prefer). Using a separate
column for each block surface and each type of frictional force (i.e. “Static friction of
small wood surface”, “Kinetic friction of small wood surface”, “Static friction of large wood
surface”, . . .), labeled appropriately, complete the following analysis

1. Plot the average force of static friction and the average force of kinetic friction versus
the normal force on the cart (both should be on the same plot). Give your plot an
appropriate title, axes labels indicating units and any other formatting necessary for
it to be easily understood.

2. Fit a line to the data using the “linear fit” option in the “Analyze” menu (in Excel
you would use the “add trendline” option). Record the slope of the line - this is the
value of the coefficient of friction for the particular type of friction (static or kinetic)
being plotted.

3. From your uncertainty in the force of friction with the cart fully loaded, estimate
the uncertainty in the coefficient of friction from δµ ≈ δf

mg
(note this neglects the

uncertainty in the mass because the total uncertainty will be dominated by δf)

4. Print out your graphs and record on each the measured coefficients of kinetic and static
friction, along with their associated uncertainty.

5. Do your measured values for µs between the large and small wood surfaces on the table
agree with each other within the experimental uncertainty? Do they differ from the
coefficient of static friction observed in the experiments with the felt surfaces? Which
surface had the higher value for the coefficient of static friction?

6. Was the measured value of the coefficient of kinetic friction less than that of static
friction for each surface being considered? If not postulate a reason why it wasn’t.

Save your work onto your flash drive or your own laptop to keep until the end of the semester.
You may need it later and files left on the lab computers will be deleted.
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Experiment 8

Work and Energy

Objective

To validate the work-energy theorem and to study the conservation of energy principle.

Theory

The work-energy theorem states that the net (total) work done on a system is equal to
its increase in kinetic energy. You will determine the work done on a (nearly) frictionless
cart and show that the work done is equal to the increase in kinetic energy of the cart.
Furthermore, you will show that the increase in energy of the cart is equal to the decrease
in potential energy of the falling weight that supplies the force on the cart.

The apparatus consists of a cart that is accelerated along a linear track by the constant
force due to the tension in a cord attached to a falling mass. The cord passes over a pulley
mounted on a rotation sensor that will be used to determine the velocity of the cart as a
function of time.
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Practice

1. Consider a pulley of radius 15 mm rotating at an angular velocity of 67 rad/s. What
is the linear velocity of a cord moving over the pulley rim without slipping.

2. Given a mass m1 ± δm1 and m2 ± δm2 moving at speed v ± δv calculate the kinetic
energy and its associated uncertainty for the system (i.e. KE±δKE).

3. Given a mass m1±δm1 at a height h±δh calculate the potential energy and associated
uncertainty, i.e. h± δh.

Procedure

1. Make sure the handheld data logger is turned on, the digital rotation sensor is plugged
in and the unit is reading an angle.

2. Load the cart with about 1kg of mass and record its loaded weight as mc

3. To simulate a frictionless system, tip the track until the cart rolls toward the pulley at
a constant speed. (No forces should be acting on the cart!)

4. Use vernier calipers to measure r, the radius of the pulley on the rotation sensor which
the cord will pass over.

5. Select a falling mass, mf between 0.05 kg and 0.20 kg, that is different than that
your lab partner used. Weigh it together with any mass hanger that you might use to
connect it to the end of the string.

6. Place the cart at the starting position, record the height of the falling mass as h0 begin
recording data on the data logger by pressing and release the cart.
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7. Transfer the collected data onto one of the lab computers for analysis by connecting
it via a USB cable and opening “Data Logger Pro” on the computer. The device will
be auto-detected and you will be prompted to import the data. If you are successful
you can skip step ??, otherwise see the instructions for manually importing data in
the next step.

8. If your data did not import automatically, save your data on the handheld device by
selecting “save” from the “file” menu. Then when it is connected to the computer,
select “LabQuest Browser” from Logger Pro’s “File” menu and select the file that you
just saved.

9. Correct the column names that are automatically created. Since you were using a
rotation sensor it was the angular displacement ∆θ, angular velocity ω and angular
acceleration α that were recorded. Double click on the column headers and correct the
titles for these columns.

Analysis

1. On your spreadsheet remove any data points that were before the cart was released
or after it had reached the end of the track. Highlight the rows associated with these
data points and select “Strike Through Data” from the “Edit” menu.

2. Create calculated columns for the linear displacement ∆x = r∆θ and linear velocity
v = rω using your measured values for r and the columns for ∆θ and ω

3. Create a column for the kinetic energy of the falling mass KEf = 1
2
mfv

2 and one for
the kinetic energy of the rolling cart KEc = 1

2
mcv

2, and finally a column for the total
kinetic energy KEtot = KEf +KEc

4. Create a column for the potential energy of the falling mass, relative to the ground.
Using h0 as the starting distance for the falling mass above the ground, the potential
energy is PE = mfg(h0 −∆x)

5. Create a column for the work done on the system by gravity Wg = mfg∆x

6. Uncertainty in ω: The rotary motion sensor has a sensitivity of 1 degree. Using the
time interval ∆t between successive data points (which you can determine from the
data column) calculate the uncertainty in ω, δω = δ(∆θ)/∆t. Make sure to convert to
rad/s.
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7. Using your estimated uncertainty in the mass of the cart (δmc), falling mass (δmf ),
pulley radius (δr) and angular velocity (δω), determine the equation for the uncertainty
in the kinetic energy. Create a new calculated column using this equation. From the
expression for kinetic energy KE = 1

2
Mtot(rω)2 the uncertainty can be found using

equation B.2, the product rule for calculating uncertainties:

δKE = KE

√(
δMtot

Mtot

)2

+ 4

(
δr

r

)2

+ 4

(
δω

ω

)2

where Mtot = mc +mf and the uncertainty in this quantity (δMtot) can be found from
the equation B.1, the sum rule for adding uncertainties. Note the factor of 4 in front of
the last two term arises because the quantities r and ω are squared in the expression
for KE so its uncertainty appears twice and is correlated so the two uncertainties add
directly (not in quadrature).

8. Determine an expression for the uncertainty in potential energy PE = mfgh = mfg(h0−
r∆θ) again neglecting the uncertainty in ∆θ. (hint first find the uncertainty in the first
term mfgh0 due to the uncertainty in mf , then find the uncertainty in the second term
−mfgr∆θ due to the uncertainties in mf and r then add these uncertainties using the
sum rule for adding uncertainties.) Enter this expression into another new calculated
column.

9. From your calculated uncertainty in kinetic energy and potential energy, calculate the
uncertainty in the total energy Etot = KE + PE and enter the expression into a new
calculated column.

10. Use the product rule for combining uncertainties to determine an expression for the
uncertainty in the total work done on the system Wg = mfg∆x. Enter this expression
in a new calculated column.

11. Plot the total kinetic energy, the potential energy of the falling mass and the total
energy as a function of ∆x along with error bars for each quantity. Is the total energy
constant within the experimental uncertainty? (i.e. if it is possible to draw a horizontal
line on the graph that passes through all of the error bars in total energy then you
have shown that energy was conserved)

12. Plot the work done by gravity on your graph, along with its associated uncertainty.
Does the work agree with the change in total kinetic energy within the experimental
uncertainty?
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Save your work onto your flash drive or your own laptop to keep until the end of the semester.
You may need it later and files left on the lab computers will be deleted.

Report

In addition to the standard elements of a well written lab report described in the introduction
to this manual, your report must include:

1. Expressions for the energy uncertainties.

2. A formula showing how each quantity you report on (Work, Kinetic Energy, Potential
Energy, Total Energy) was calculated from the measured parameters (there is no need
to include the full spreadsheet though)

3. A single graph of Work, Kinetic Energy, Potential Energy and Total Energy versus
displacement with error bars for each quantity that summarize your analysis.

4. Your statement of observations and conclusions. If the total energy of the system was
not constant, is its variance reasonable in light of the experimental uncertainties?
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Experiment 9

Conservation of Linear Momentum

Objective

To compare the sum of the momentum vectors before and after a two-dimensional collision
of steel balls. To demonstrate the principle of conservation of linear momentum.

Theory

A consequence of Newton’s laws of motion is that during a collision of objects, the total
momentum of the objects remains constant. Consider that Newton’s second law states

~F =
d~p

dt
,

with ~p = m~v this reduces for objects with a constant mass to ~F = md~v
dt

or in the more

familiar form ~F = m~a. The original form can be rewritten as ∆~p = ~F∆t. Newton’s third
law states that the force exerted by an object on another is equal in magnitude and opposite
in direction to the force that the other object exerts on the original object, which can be
expressed by

~F12 = −~F21

so we can say that the momentum change for object 1 is ∆~p1 = ~F21∆t when it collides
with object 2 and is in contact for a time ∆t, while for object 2 the momentum change is
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∆~p2 = ~F12∆t and thus the total momentum change is ∆~ptot = ∆~p1+∆~p2 = (~F12+ ~F21)∆t = 0,
i.e. the total momentum for the system is conserved. We will test this relationship by
observing the momentum of two objects before and after they collide.

Practice

Consider an object of mass 2 kg moving with a velocity of ~v = 0.3 m/s x̂+ 0.4 m/s ŷ. What
is the momentum for this object?

Procedure

Each student will record the collision of a pair of steel balls. The resulting video will be
analyzed with the help of “Logger Pro” data analysis software to determine the velocity of
each ball before and after the collision.

1. Record the mass of each steel ball.

2. Mount the webcam using the supplied mounting equipment so that it is looking straight
down at the floor.

3. Open “Logger Pro” and select “Insert → Video Capture . . .” to get a video preview.
You can change the resolution of the video by selecting the “Set up camera” button.
The 800x600 setting provides a good balance of high resolution with reasonably fast
frame rate.

4. Place a meter stick on the floor completely in the frame of the video (this will be used
to calibration distances in the video)

5. Plan out the path you want the pair of balls to follow: Place the starting ramps fully
outside the field of view of the camera so that when released one ball approaches the
other and they collide directly underneath the camera and then exit the field of view in
a straight line before being stopped - if the balls acquire spin during the collision they
may travel in a curved path making the data analysis problematic. If you observe this
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repeat the experiment until you achieve a collision where the spin is negligible - it may
help to decrease the speed of the balls. It will require careful timing, practice and a
bit of luck to get the balls to collide properly. Try several times to get the timing right
for a collision. If you are unable to get a collision with both balls rolling towards the
collision point, you can instead start with one ball at rest directly under the camera.

Analysis

To analyze the video you will use the program “Logger Pro” on the lab computers. Refer to
the figure below for location of various buttons. Use the following procedure to analyze the
motion of your recorded collision.

Figure 9.1: Logger Pro video window with video analysis toolbar enabled

Set up video for motion analysis

1. Open the video analysis toolbar by clicking on the button with three red dots in the
bottom corner of the movie window.
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2. Set an origin for your coordinate system using the “Set Origin” button of the video
analysis toolbar.

3. Calibrate the scale of the video using the image of the meter stick by clicking the “Set
Scale” button and drawing a line the length of the meter stick and entering 1 m for
the line length.

4. Position the playhead at the first frame where both balls are in the video frame and
are moving freely (i.e. are not still on the ramp). This will be your first data frame.

Capture the motion

1. Click the “Add Point” button, then click on the center of the first ball. The video will
advance by one frame immediately after you click.

2. Continue to click on the center of the same ball in all additional frames until the first
of the two balls has moved off screen - this will be your last data frame.

3. Click the “Set Active Point” button and select “Add point series” from the popup
menu.

4. Return the playhead to the first data frame. Click on the center of the second ball to
identify its location, and continue to click on the center of the ball in each successive
frame until the last data frame.

5. Save your data. If your computer crashes or Logger Pro scrambles your data you
don’t want to have to go through that time consuming step again!

Determine the momentum

As you were recording the position of each ball in each frame, the properly scaled x and
y coordinates were being added to data columns in the logger pro spreadsheet. Additionally
columns for the x and y components of velocity were generated from the position columns.
We will complete the spreadsheet by creating columns for the components of the momentum
vectors adjusting the origin of the time axis to be at the moment of collision, and adjusting
for the effect of external forces on the system. You can choose to do the analysis directly
in logger pro (using the instructions below) or you can choose at this point to export your
data in “csv” format to import into Excel or another spreadsheet for analysis.
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1. Looking at the graph of position versus time that was generated when you captured the
motion, determine the time t0 at which the collision occurred. Since the collision may
have occurred between two frames of the video, it may be necessary to estimate the value
between the two points closest to the collision. This process is called interpolation.

2. Record the time of collision as a parameter. Select “User parameters. . .” from the
“Data” menu, and add a parameter t0 for this quantity, giving it an appropriate name
and recording the numerical value. While you are in the edit parameters menu add a
parameter for the mass of each ball m1 and m2 and enter the numerical values, and
create two parameters that we will use to remove the effects of external forces that you
can call Fx and Fy. You can leave the values of these set to zero for the moment.

3. Create a column for time relative to the collision. Click “New calculated column. . .”
from the “Data” menu and give the new column an appropriate name (in both the
“Name:” field and the “Short Name:” field). In the equation panel create a formula
for this column of the form tr = t− t0 by clicking in the equation panel to get a cursor
there, selecting “Time” from the list of variables, typing in the minus symbol, then
selecting the collision time parameter t0 from the parameters list. You will use this
same method to enter formulas in the other calculated columns that you create in the
next few steps.

4. Create a calculated columns for the momentum of ball 1 in the x-direction of the form
p1x = m1v1x. Repeat three more times for p1y, p2x and p2y.

5. Add another calculated column for the corrected total momentum in the x-direction
using the formula px = p1x + p2x − Fx ∗ tr where tr is the relative time column you
created earlier and Fx is a parameter that corrects for any external forces. We will use
the term Fx ∗ tr to subtract the momentum gained (or lost) from external forces such
as friction or due to the floor not being level, however at the moment Fx = 0 so this
term has no effect. Repeat for the total momentum in the y-direction.

6. Determine the appropriate correction factor for external forces. Plot the x-component
of total momentum versus relative time (px vs tr) by clicking on the y-axis label of
the graph and selecting the appropriate column for px and clicking on the x-axis label
and selecting the appropriate column for tr. If the data has an overall upwards or
downwards trend to it then an external force was pushing (or pulling) it in the x-
direction. We’ll check the magnitude of this effect and then compensate for it. Perform
a linear fit to the data by choosing “Linear Fit” from the “Analyze” menu. The
parameters of the fit will be shown on the graph. Note the slope of the fit, and record
this as the value of your parameter Fx by accessing the “User Parameters. . .” option
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from the “Data” menu again. Once you have done this the momentum data should
adjust to remove this trend. Repeat for the y-component of total momentum.

7. Add a calculated column for the magnitude of total momentum

ptot =
√
p2x + p2y

where you use the appropriate columns for px and py.

8. Add a calculated column for the angle of total momentum

θtot = tan−1
[
py
px

]
where you use the appropriate columns for px and py.

9. Add a calculated column for the total kinetic energy

KEtot =
1

2
m1(v

2
1x + v21y) +

1

2
m2(v

2
2x + v22y)

where you use the appropriate columns for v1x, v2x, v1y and v2y.

Statistical Analysis

You will use the columns for the kinetic energy, magnitude and angle of the total momentum
to determine the average and standard deviation of these values before and after the point
of the collision.

1. Double click on the “y-axis” of your graph and in the “Axes Options” tab select kinetic
energy, magnitude and angle of the total momentum as the (only) three columns to
plot.

2. Select “Statistics” from the “Analyze” menu. Select your columns for total magnitude
of momentum and angle of momentum vector for analysis.

3. Adjust the brackets so that only the data before the collision point (i.e. tr < 0) is within
the brackets. Record the mean values as your measurement and the standard deviations
as your uncertainties in the initial magnitude and angle of the total momentum and
the kinetic energy.
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4. Adjust the brackets to enclose only the data after the collision (i.e. tr > 0) and
record the mean values as your measurement and the standard deviations as your
uncertainties.

5. Compare your initial and final momentum (magnitude and angle) for both collisions.
Was momentum conserved?

6. Compare your initial and final energy. What percent of the initial energy was lost in
the collision? Would you classify this collision as a fully elastic, partially inelastic or
fully inelastic collision?

Save your work onto your flash drive or your own laptop to keep until the end of the semester.
You may need it later and files left on the lab computers will be deleted.

Report

In addition to the standard elements of a well written lab report described in the introduction
to this manual, your report must include:

1. A printout of the graphs of the magnitude and angle of momentum, as well as kinetic
energy for your collision. You will need to plot these quantities separately so that each
graph can have the y-axis scaled and labeled appropriately for each quantity. Make
sure the y-axis scale starts at zero so that the relative magnitude of any fluctuations
can be seen on the graph.

2. A conclusion, addressing the two questions asked in the statistical analysis section
under steps 3e and 3f.
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Experiment 10

Ballistic Pendulum

Objective

To use a ballistic pendulum to determine the velocity of a projectile. To verify this velocity
by measuring the range of the projectile.

Theory

We use measurements obtained from a ballistic pendulum to review energy conservation,
momentum conservation, and projectile motion. From the measured recoil speed of the
pendulum we determine the speed of a ball fired by a spring-loaded cannon. We check this
speed by measuring the range of a ball fired horizontally from the cannon from the bench
top to the floor.

The spring-loaded cannon fires a steel ball with sufficient speed to shatter eyeglasses. Use
appropriate caution. Don’t look down the barrel; you can see from the side whether the
spring is cocked and if the ball is in place. Don’t leave a cocked and loaded cannon on the
bench.

To determine the initial velocity of the steel ball fired from the “canon”, we apply two
conservation laws, the conservation of momentum (during the collision) and the conservation
of energy (after the collision). Conservation of momentum relates the velocity of the ball
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before the collision with the velocity of ball plus pendulum after the collision, according to

mbv0 = (mb +mp)vr

Conservation of energy relates the initial (kinetic) energy of the pendulum to its final (po-
tential) energy, according to

1

2
(mb +mp)v

2
r = (mb +mp)gh

where h is the maximum height reached by the center of mass of the pendulum. Using these
two relations, we can determine the velocity v0 of the ball when it is shot from the cannon.

Figure 10.1: The operation of the ballistic pendulum

Practice

1. Consider a ball of mass mb moving with speed v0 colliding inelastically with an object
of mass mpthat is initially at rest. What is the speed vr of the two objects immediately
after the collision in terms of v0, mb, and mp?

66



EXPERIMENT 10. BALLISTIC PENDULUM

2. Consider the bob of a pendulum of mass m moving at speed vr at the bottom of the
arc of the pendulums motion. Using conservation of energy, find the maximum height
hmax that the pendulum bob will swing to.

3. For a pendulum of length L that swings an angle θ so that the pendulum bob rises to
a height of h draw a diagram and use trigonometry to find an expression for the maxi-
mum height of the pendulum hmax as a function of the maximum angular displacement
of the pendulum θmax

4. Using your results from the previous problems, find an expression for the initial speed
v0 of a ball in a ballistic pendulum that produces a maximum angular displacement of
θmax

Procedure

1. Remove the pendulum from the stand by unscrewing the pivot axle. Weigh and record
the masses of the pendulum mp and the steel ball mb.

2. With the ball latched in the catcher, balance the pendulum on a ruler or pencil to
locate the center of mass. Measure and record as rcm, the distance from the pivot axis
to the center of mass.

3. Reattach the pendulum to the stand. Check that it swings freely. With the pendulum
hanging vertically, move the angle pointer to just contact the pendulum arm. Record
this angle as θ0.

4. With the pendulum latched at 90o, insert the steel ball and use the ramrod to cock the
spring to its middle or maximum range position. Let the pendulum hang vertically and
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move the angle pointer to θ0. While holding the base firmly against the table fire the
cannon by pulling up on the trigger. Observe carefully the angle indicator to ensure
that it stays at the maximum angle (if it slides back a few degrees from its maximum
displacement due to insufficient friction you will have to use a different apparatus).
Write down the maximum angle recorded by the angle indicator.

5. Repeat this process five times to check the reproducibility of the apparatus. Be sure
to cock the cannon to the same setting each time. To minimize drag on the pendulum
set the angle indicator initially to about 5o below the maximum recoil angle. Record
the maximum recoil angle, θmax, for each shot.

Analysis

1. Compute the average value of the recoil angle θ = θmax − θ0

2. Find the change in height of the center of mass hcm = rcm(1− cos θ).

3. Calculate the recoil velocity vr =
√

2ghcm being sure to use three significant figures for
g; g = 981 cm/s2.

4. Calculate the initial velocity of the steel ball v0 =
(
mp+mb

mb

)
vr. Express this quantity

as a value plus or minus its uncertainty, thus: v0 ± δv0 where

δv0 = v0

√(
δm2

p + δm2
b

(mp +mb)2

)
+

(
δmb

mb

)2

+

(
1

2

δrcm
rcm

)2

+

(
1

2

sin θ

(1− cos θ)

π rad

180o
δθ

)2

and the uncertainty in angle δθ is measured in degrees.

5. Now calculate where the ball would land if it were shot horizontally with this initial
velocity from on top of the lab bench. The range is given by x = vot where v0 is the
initial velocity of the ball and t is the time of flight. You’ve found the uncertainty
in step 3d and the uncertainty in time for an object that fell a distance y ± δy was
something you calculated in experiment 1, so you can find the uncertainty δx using
these quantities and the product/quotient rule for uncertainty. the velocity in the The
time of flight can be determined from the fact that the distance the ball falls vertically
is given by y = 1

2
gt2. Place a piece of graph paper this distance away and tape it to

the floor. Mark the predicted landing spot with an x and draw a line a distance tδv
beyond the x, and another line the same distance before the x, this is your uncertainty
in the range.
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6. Now remove the pendulum and fire the ball horizontally. (make sure it does not hit
anyone.) Observe where the ball hits the floor – it will make a mark on the carbon
paper. Repeat 10 times. If you have properly calculated your uncertainty 7 out of the
10 trials should hit between the lines.

Figure 10.2: Projectile motion from the cannon

7. Does the value of the range calculated using your measured value for v0 agree with the
observed range?

8. Finally, compute the percentage of the balls initial kinetic energy that was lost when
the ball collided with the pendulum arm.

Report

In addition to the standard elements of a well written lab report described in the introduction
to this manual, your report must include:

1. A neat and organized presentation of all measured and calculated values.

2. A calculation of the percent uncertainty in the calculated range and the measured
range of the projectile. How many of your shots landed within the uncertainty range?
What can you conclude from this?

3. A final comment on whether or not mechanical energy was conserved. If not, is that
what you would expect in this type of a collision?
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Experiment 11

Rotational Dynamics

Objective

To investigate the relationship between torque and angular acceleration and to verify the
work-energy theorem for rotational motion.

Theory

The rotational analogue to ~F = m~a is ~τ = I~α where ~τ is torque, I is the moment of inertia
and ~α is the angular acceleration. If we apply a torque to a body that can rotate about
a fixed axis, it will undergo an angular acceleration and a change in its angular velocity,
therefore, its rotational kinetic energy will change. The rotational kinetic energy is given by
KE = 1

2
Iω2 , where ω is the angular velocity (radians per second).

Practice
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Consider an object of mass m at rest hanging from a string that is coiled around
a pulley with an inner radius of r and an outer radius of R as shown to the
right.

1. What is the torque exerted by the string on the pulley about its axis?

If the mass begins to fall it will produce a constant angular acceleration on the pulley
as the string is unwinding, and a constant angular acceleration of opposite sign as it
winds back up.

2. If the instantaneous angular displacement and angular velocity are as plotted on the
above graphs, what is the magnitude of this constant angular acceleration (be sure to
include the correct units)?

3. What was the maximum angular velocity of the pulley?

4. What was the angular displacement of the pulley as it was spinning up?

72



EXPERIMENT 11. ROTATIONAL DYNAMICS

Procedure

Your instructor will demonstrate proper operation of the apparatus. An aluminum disk
(or bar) is attached to a “quadrature encoder” based rotation sensor that spins about a
horizon axis and relays information about its angular displacement to a hand-held data
logger. Angular acceleration is produced by the tension in a cord attached to a small load
mass. Although you will work in groups of two, each student should record his or her own
data using a different value for the small load mass.

1. Remove the aluminum disk (or bar), and spool and measure their mass, and radius (or
length and width as appropriate). Record these values in a data table.

2. Reassemble the system with the thread anchor washer and a small spool attached to
the disk with the screw.

3. Ensure that the rotation sensor is plugged into the side of the data logger and that the
unit is reading a value for the rotation angle, and that it is set to record for 20s (as
displayed in the box labeled “Length”). If the recording length needs to be adjusted,
tap on the box labeled “Length” then enter the new value.

4. Wind the string around the spool, lifting the small load mass until it is just below the
bottom of the disk (or bar). The first group member should start with 25 g of mass on
the hanger and each group member should add an additional 5 g before taking their
data.

5. Start logging data on the hand-held data collector by pressing . Release the system
from rest and allow the data logger to collect angular displacement and angular velocity
data over a 20 second interval as the load mass falls and then returns up towards its
starting point. The resulting graph of ω vs t shown on the data logger should look like
a “saw tooth” function as shown below.
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6. Determine the angular acceleration of the disk from the plot of angular velocity vs. time
by selecting the region of the graph (tap the stylus and drag to select a region) just after
the mass was released from rest, but before it had reached the bottom (i.e. the first
line segment of the saw tooth graph). Choose “curve fit” from the “analysis” menu
and select “velocity” and then choose a “linear” curve fit form the “Fit Equation”
pull down menu. Record the value for m the best fit slope, with appropriate units
taken from the graph. Call the magnitude of this value α−, the magnitude of angular
acceleration when the applied torque opposed the frictional torque. Repeat for the
region just after the mass had reached the bottom but before it had wound all the way
up calling the magnitude of the slope α+ the magnitude of angular acceleration when
the applied torque is in the same direction as the frictional torque.

7. When the spool is unwinding the applied torque is opposed by friction, while when it
is winding up the applied torque adds to the frictional torque to decelerate the disk,
thus the magnitude of the acceleration due to only the applied torque is the average
magnitude of the acceleration αa = (α+ + α−)/2. Calculate this value. Also compute
the difference in the magnitude of angular accelerations ∆α = |α+ − α−|, this is a
measure of the effect of only the frictional torque and will be used to determine the
energy dissipated by friction.

8. Estimate and record the maximum value of the magnitude of the angular velocity
(ωmax). Logger Pro determines the angular velocity at a given time by comparing the
angular displacement at an earlier and latter time and assuming the velocity in that
time interval is constant. At the kinks in the curve (where the angular velocity is a
maximum) this is not a valid assumption and results in the sharp corners of the tri-
angular curve being rounded and the reported angular velocity being underestimated.
To find the maximum angular velocity extrapolate the linear regions of the graph and
find the angular velocity from the point of intersection on the graph as shown below.
Also record ∆θ, the magnitude of the angular displacement between the time when the
disk began rotating (i.e. the starting point), until when it was moving at its maximum
angular speed. These values will be used for energy calculations.
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9. Repeat the experiment 2 more times to obtain three values for αa. Find the average
and standard deviation of these three values to use as ᾱ and δα respectively in your
calculations.

Analysis

1. Tension. Calculate the tension in the cord T and its associated uncertainty δT . The
linear acceleration of the falling mass, a , is so small it can be ignored: T = mf (g−a) ≈
mfg with δT = δmg.

2. Applied Torque. The applied torque on the pulley is ~τa = ~T × ~r , but in our case the
tension in the string is perpendicular to the radius of the spool so the magnitude of the

torque can simply be expressed as τa = Tr with uncertainty δτa = τa

√(
δT
T

)2
+
(
δr
r

)2
.

3. Moment of inertia. The moment of inertia can be calculated from I = τ
α

with uncer-

tainty δI = I

√(
δτa
τa

)2
+
(
δα
α

)2
. Compute your experimental value for the inertia of

the disk (or bar) from the applied torque found in step 3b and the acceleration found
in step 3i of the procedure and compare it to the calculated value found from the mass
and dimensions of the disk (or bar): Idisk = 1

2
mdr

2
d and Ibar = 1

12
mb(L

2 + w2)2. Do
these values agree within the experimental uncertainty?

4. Finally, check the work-energy relation, which state the total work done on a system
equals the change in kinetic energy. There are two forces (gravity and friction) that
do work on the system as the disk is spinning up: Wg = mgh where h = ∆θr is the
height the load mass fell while the spool was unwinding, and Wf = −τf∆θ, where
τf = |I∆α/2|. The change in kinetic energy also has two terms (one for the rotation
of the disk and one for the falling mass) the rotational kinetic energy of the disk is
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KErot = 1
2
Iω2 while the linear kinetic energy of the falling mass is KElin = 1

2
mv2 where

v = ωr. Relate the total work done on the system as the disk spins up to the change
in kinetic energy for one of your trials (i.e. don’t use the average values for ωmax or
∆θ since averaging the square of the values is not the same as squaring the average!).
What is the percent difference in the total work done and the change in kinetic energy?
How does this compare to the experimental uncertainty (the experimental uncertainty
will be dominated by the uncertainty in your measured value of I, so you can use
(δI/I) × 100% for the percent experimental uncertainty.) Are they equal within the
experimental uncertainty?

Save your work onto your flash drive or your own laptop to keep until the end of the semester.
You may need it later and files left on the lab computers will be deleted.

Report

In addition to the standard elements of a well written lab report described in the introduction
to this manual, your report must include:

1. A data table.

2. A comparison of the known and the experimental values of the moment of inertia.
These values should agree to within the experimental uncertainty. If they do not,
then state the sources of uncertainty in this experiment that could have caused this
discrepancy.

3. A comparison of the total work done on the system and the maximum kinetic energy
of the system. Do these values agree? Recall the Work-Energy Theorem.
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Example Data and Results Table

Disk Radius rd =

Spool Radius r =

Disk Mass md =

Falling mass mf =

Trial α− α+ αa = |α+|+|α−|
2

∆α = |(|α+| − |α−|)| ωmax ∆θ
(rad/s2) (rad/s2) (rad/s2) (rad/s2) (rad/s) (rad)

1
2
3

avg
stdev
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Experiment 12

Angular Momentum

Objective

The object of this experiment is to observe and analyze one-dimensional rotational collisions
between a disk and a bar rotating about a common axis. You will test the law of conservation
of angular momentum and determine whether or not rotational kinetic energy is conserved
during the collision.

Theory

Angular momentum ~L = I~ω is a useful quantity for analyzing the motion of objects over
time because it is a “conserved” quantity. To understand this, consider the time derivative
of angular momentum

d~L

dt
= I

d~ω

dt
.

Recognizing that the term d~ω
dt

on the right side of this expression is the angular acceleration
~α = dω

dt
, and using Newton’s 3rd law for rotational motion ~τ = I~α we can say that

d~L

dt
= ~τ .

This implies that if no outside torques act on a system, the angular momentum of the system
will not change in time.
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Experiment

In this experiment you will devise your own procedure for comparing the angular momentum
of a set of objects before and after a collision involving one stationary object being dropped
onto a rotating object. You have a rotation sensor, calipers and rulers, a scale, and a pair of
objects that can be placed on the rotation sensor (two disks or a a disk and a bar depending
on your apparatus). As you develop a procedure consider the following important points:

1. The moment of inertia for a uniform disk of mass m and radius r rotating about its
center of mass is Idisk = 1

2
mR2

2. The moment of inertia for a uniform bar of mass m length L and width w rotating
about its center of mass is Ibar = 1

12
m(L2 + w2)

3. Angular momentum is only conserved if no external torques act on the system - how
can you avoid introducing unwanted external torques when you drop one object onto
the other?

4. When one stationary object is dropped onto another the “collision” is not instantaneous
- it takes some time for the stationary object to spin up and the rotating object to
slow down until they are moving at a common angular velocity.

5. Friction in the rotation sensor is an unavoidable external torque and may cause the
system to gradually lose angular momentum. If you are comparing angular momentum
before the collision and after the collision you’d expect there to be a difference due to
any frictional losses. How can you take this into account?

Analysis

What are the sources of uncertainty in your measured values for the angular momentum?
Are you able to show that momentum is conserved within this uncertainty range?

Because there is friction between the objects as they collide we expect energy to not be
conserved. In addition to comparing the angular momentum before and after the collision,
determine the total rotational kinetic energy (KErot = 1

2
Iω2) of the system before and after

the collision. What percentage of the kinetic energy was lost in the collision?
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Save your work onto your flash drive or your own laptop to keep until the end of the semester.
You may need it later and files left on the lab computers will be deleted.

Report

In addition to the standard elements of a well written lab report described in the introduction
to this manual, your report must include:

1. A detailed description of your experimental procedure

2. A detailed description of your analysis

3. Your momentum graph and energy graph

4. A conclusion in which you address the following:

(a) Whether or not angular momentum was conserved.

(b) Whether or not the energy of the system was conserved.
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Experiment 13

Numerical Analysis

Objective

The objective of this experiment is to examine the accuracy of numerical solutions to analyt-
ical expressions and to determine the effect of a velocity-dependent drag force on a moving
object by using computer-assisted numerical methods to solve Newtons equation of motion.

Concepts

Projectile kinematics homework problems instruct you to neglect air resistance because the
velocity-dependent drag force invalidates the simple constant-acceleration solution. Fortu-
nately nature ignores this hint; otherwise raindrops would hit with lethal impact. This week
we learn to compute numerical solutions to Newton’s equation of motion that include the
effect of air resistance. Many real-world engineering and science calculations are set up this
way.

For a moving spherical object, such as a baseball, the forces acting on the object are gravity
and a drag force due to air resistance. The drag force has two main characteristics; it
opposes the direction of motion and it increases in magnitude with increasing velocity. We
shall assume the drag force is proportional to the velocity squared.
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Figure 13.1: Free body diagram for a falling baseball

Newtons 2nd law in the vertical direction is written as:

Fd −mg = ma

with Fd = 0.22d2v2. As the ball falls, the velocity increases until the drag force balances the
gravitational force so that the net force is zero.

To predict the motion of the ball, we need to calculate the resultant force and velocity
produced by the drag using simple step functions over a small time interval in which the
acceleration is assumed constant. New values of position and velocity are calculated from
previous values of velocity and acceleration. The repetitive arithmetic in these step equations
is just what computers were developed for. These equations use the simplest estimate for
the velocity and acceleration in each interval. The larger the interval the less accurate the
estimate over this interval is. Our text book develops slightly more detailed expressions, but
the core concept for this and all the more sophisticated treatments is the same: if we know
the forces, Newtons second law lets us predict the motion.

Calculations

1. Air Resistance on a Baseball. A thrown ball will encounter an air resistance force
proportional to the square of its diameter d and its speed v. This drag force is given
by

Fd(v) =

(
0.22

kg

m3

)
d2v2
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for air at STP. The constant (0.22) has units of kg/m3 so that when MKS units are
used for diameter and velocity the resulting force is in Newtons. When the sphere
reaches its terminal velocity vT , the net force on the sphere is zero, so from Newtons
second law we have (

0.22
kg

m3

)
d2v2 −mg = 0.

If a baseball is at hand, measure the diameter and mass of the baseball and compute
its terminal velocity. If a baseball is not available, assume its mass is 0.14 kg and its
diameter is 0.072 m.

2. Free Fall from Rest. A baseball is dropped from rest. Use the spreadsheet program
Excel to evaluate the motion over a large number of small time steps. Enter the
n=0 row of initial values. Define the n=1 elements as equations using previous values
and constants. Then use the fill down command (in the Edit menu) to repeat the
calculations for as long and as far as you want the baseball to fall. Program each of
the following equations into the following columns, using references to cells containing
the value for ∆t, vT , g, and m. You can use a time step of ∆t = 0.1vT/g which is
one tenth of a characteristic time vT/g describing how long before the effects of drag
become significant. In step 3c we will investigate the significance of this value. The
first couple of rows in your spreadsheet should look similar to this

Figure 13.2: Example of the first row of the spreadsheet

where the values mg and g reference the cells where these constants have been defined.
The value of successive cells in the nth row of data should be calculated from the
following formulas:

(a) Index: n

(b) Time: tn = tn−1 + ∆t

(c) Exact solution to velocity without a drag force acting: vn = −gtn
(d) Exact solution to distance without a drag force acting: yn = −1

2
gt2n
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(e) Net force for numerical solution without drag force acting: Fn = −mg
(f) Acceleration for numerical solution without drag force acting an = Fn/m

(g) Numerical solution to velocity with drag force acting: vn = vn−1 + an−1∆t

(h) Numerical solution to distance with drag force acting: yn = yn−1 + vn−1∆t (the
1
2
a∆t2 term can be neglected for sufficiently small timesteps)

(i) Net force for numerical solution with drag force acting: Fn = 0.22d2v2n −mg
(j) Acceleration for numerical solution with drag force acting an = Fn/m

Plot velocity and position as functions of time for at least 32 points. Highlight the
column of time values. Holding the ctrl key to skip columns, also highlight the two
columns of velocity values. Then select Chart from the Insert menu and Excel will
guide you through the plotting options. Show on this graph the terminal velocity you
calculated. Also plot distance as a function of time, again comparing the drag-free case
to the realistic solution.

3. Effect of Timestep. Set the diameter d to zero in your spreadsheet. This has the
effect of eliminating air resistance form the numerical solutions (if this causes division
by zero errors in your cells, don’t worry, the issue will be resolved once you manually set
the timestep Deltat ). We will observe how changing the time step affects the accuracy
of these solutions. Set the time step to 2 seconds. Record the exact position of the ball
at 2 seconds and the numerical solution to the position at 2 seconds. Reduce your time
step by a factor of 2 (i.e. set it to 1 second) and again record the exact and numerical
solution to the position at 2 seconds (because the time step has changed, these values
will be in a different row than before). Continue decreasing the time step by factors
of 2 down to 1/16th of a second, recording the position of the ball at 2 seconds for
the exact and numerical solutions for each time step. Determine the percent error in
the numerical solution at each time step by comparing it to the exact value. Below
what value for the time step does the error decrease to less than 10%? How does this
compare to the value of ∆t used in step 3b? Explain why smaller time steps give less
error and why there is diminishing value to having time steps less than δt = 0.1vT/g
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Data Table

Timestep Exact value for y(2 s) Numerical solution to y(2 s) % difference

2 s
1 s
1
2

s
1
4

s
1
8

s
1
16

s

Report

In addition to the standard elements of a well written lab report described in the introduction
to this manual, your report must include:

1. A combined graph including curve of exact velocity without drag vs. time, and the
curve of numerical solution to the velocity with drag vs. time. Indicate on the graph
what the terminal velocity is and what the mass and diameter of the ball are for the
results appearing in the graphs.

2. A combined graph including the distance fallen as a function of time for the exact
solution without drag and the numerical solution with drag.

3. Printout of the spreadsheet data table.

4. A conclusion discussing what you have learned regarding how the time scale used in
numerical calculations affect the accuracy of the results.
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Appendix A

Example Lab Reports

The following two example lab reports show a poorly written report and a well written
report for a fictitious lab. Both use the same set of data and both are about the same
length. Compare and contrast these two reports. Which of these two reports more clearly
communicates the meaning and results of the lab? How many examples of bad style can you
find in the poorly written report?
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Example of a well written lab report

The Universal Gravitational Constant 

Background:
Newton’s law of gravitation describes the gravitational force between massive objects.  The evo-
lution of the universe, the motion of the planets, and even the behavior of everyday object can be 
explained using Newton’s equation for the gravitational force,

which says the gravitational force between two objects is directly proportional to the mass of the 
objects and inversely proportional to their separation squared.  Knowledge of the value of the 
constant of proportionality, G (called the universal gravitational constant), is fundamental to be-
ing able to apply this equation, and was experimentally measured in this lab.

Experimental Aparatus
A “torsional pendulum” was used as a tool for 
measuring the force of attraction between two 
pairs of massive objects.  The torsional pendulum 
consists of barbell like structure with 1kg masses 
(m1 in the figure) on either end of a 30cm rod of 
negligible mass.  The structure is suspended from 
its center of mass by a thin wire of length 1m, and 
the angle of the structure in the horizontal plane is 
measured using capacitive sensors.  

The angular displacement of the torsional pendu-
lum caused by a given torque is calibrated by at-
taching a string to each end of the barbell and running it over a pulley on the edge of the table so 
that a mass hanging off the string can supply a known tension to the string, while the change in 
angular displacement is recorded.

Once the torsional pendulum is calibrated, a pair of large test-masses (m2 in the figure) is placed 
a distance r from the ends of the barbell so that the gravitational force between each of the 
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masses and each end of the barbell causes a rotation of the torsional pendulum that can be meas-
ured to determine the gravitational force.  For various mass test-masses and test-mass–barbell 
separations the gravitational force is measured and the value.  The value of G is determined from 
the slope of a plot of force versus m1m2/r212.

Data
displacement vs. force calibration

Trial 1 2 3 4

Hanging mass (±0.01g) 1.00 g 2.00 g 3.00 g 4.00 g

Tension (±0.1 x 10-3 N) 9.80 x 10-3 N 19.6 x 10-3 N 29.4 x 10-3 N 39.2 x 10-3 N

Angular Displacement 
(±0.01 mrad)

0.99 mrad 2.01 mrad 2.87 mrad 4.02 mrad

gravitational force measurements

Trial 1 2 3 4

Test mass 10.0 kg 10.0 kg 20.0 kg 20.0 kg

Separation 10 ±1 cm 20 ±1  cm 10 ±1 cm 20 ±1 cm

Angular Displacement
(±0.01 nrad)

6.81 nrad 1.65 nrad 13.9 nrad 3.80 nrad

Force (±0.1 x 10-3 N) 66.7 nN 16.2 nN 136 nN 37.2 nN

Calibration curve    Force vs displacement measurements
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Analysis
The torsional pendulum was found to have a rotation of 0.102 rad per Newton of force acting on 
each of the barbell masses.   The calibrated response of the torsional pendulum was used to de-
termine the force producing the measured angular displacement of the pendulum for 4 different 
combinations of test masses and test mass positions.  When m1m2/r2 is plotted versus the meas-
ured force for each case the slope of the best-fit line is G.  G can be expressed as 
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G =
F

m1m2 /r
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with uncertainty 
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and evaluates to 0.9x1011 Nm2/kg2 .  When the results of the 4 measurements are averaged the 
resulting uncertainty is 

€ 

δGavg =
δG1( )2 + δG2( )2 + δG3( )2 + δG4( )2

4

giving an uncertainty in the average of 0. 45x1011 Nm2/kg2 , or 7% of the measured value of G.  
Taking this uncertainty into account, the measured value of G is 6.27±0.45 x 10-11 Nm2/kg2 .  

Comparing the measured value for G to the accepted value Gacc=6.67 x 10-11 Nm2/kg2 gives a 
percent difference of      
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which is less than the 7% uncertainty in the measured value, therefore the measured value of G, 
the universal gravitational constant, agrees with the accepted value.
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Example of a poorly written lab report 

Objective 
In this lab we will use weights hanging off a string to calibrate the response of a torsion 
pendulum.  Then we will put a 10kg and a 20kg weight next to the torsion pendulum and 
measure its deflection when the weights are 10cm and 20cm apart.  We will plot the value 

for m1m2/r
2 versus force and use the graph to determine the value for G.  

Data 
displacement vs. force calibration 

Trial 
1 2 3 4 

Hanging mass 
1 2 3 4 

Tension 
9.80 x 10-3 19.6 x 10-3 29.4 x 10-3 39.2 x 10-3  

Angular Displacement 
0.99 2.01 2.87 4.02 

 

gravitational force measurements 

Trial 
1 2 3 4 

Test mass 
10 kg 10 kg 20 kg 20 kg 

Separation 
10 cm 20 cm 10 cm 20 cm 

Angular Displacement 
6.81 nrad 1.65 nrad 13.9 nrad 3.8 nrad 

Force 
66.7102 nN 16.1958 nN 136.1004 nN 37.1697 nN 
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Graph 1 

 

Graph 2 
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Analysis 
We measured a value of G that was 6.27 x 10!11, which is pretty close to the accepted value 

of 6.67 x 10!11.  The percent error is 

 

The reason for the difference was probably due to a mistake that we made measuring the distance 

between the masses.  If we had been more careful we probably could have measured it better.  

Also another source of error was friction in the string and our equipment was kind of old.  





Appendix B

An Introduction to Error Analysis

An important part of presenting experimental data is the treatment of the uncertainty in
the data. This document provides a brief introduction to the topic and has a few examples
that will be useful references when you are preparing your own lab reports.

Uncertainty in measured quantities

Whenever you make a measurement there is uncertainty. Any error in the measurement can
be minimized by using care and proper experimental techniques, but it cannot be eliminated.
For example, if you are determining the mass of an object, you should be careful to “zero”
the scale before putting the object on it, and you should ensure the measurement you make
is repeatable, this will minimize the uncertainty in your measurement of the mass. When
you measure length using a meter stick, you should not measure from the end of the meter
stick, which is often worn down, but rather from a line that is more clearly defined, such
as the 1 cm line (you’d then have to subtract 1 cm from the value you read on the meter
stick). Virtually all other types of measurements that you will make will require similar
care and thought to minimize the error in the measurements. In practice when we make a
measurement what we are actually determining is a range of values that we believe contains
the actual value.

When the error in a measurement is minimized, what is left is the inherent uncertainty. It
is necessary to estimate the size of this uncertainty and record it with the value of your
measurement in your data table. If we measure a quantity a with an uncertainty δa we
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express the result as a ± δa. Both the measured value a and its uncertainty δa will have
the same units, so for example if a spring is measured to exert 10.2 N of force with an
uncertainty of 0.3 N the measured results would be expressed as F = 10.2 ± 0.3 N. The
size of the uncertainty (δa) is usually chosen to meet the following criteria: If 100 people
were to carefully repeat your measurement using the same equipment, 68 of them should
measure a value that is within the uncertainty of your measured value (i.e between a − δa
and a+ δa.) A more useful, although not as precise, method for estimating the uncertainty
in a measurement is as follows: you make a measurement of some quantity and then have
your lab partner measure the same quantity. The difference between your measurements is
an estimate of the uncertainty. Be careful though - if both of your measure exactly the same
value, this doesn’t mean there is no uncertainty - if nothing else the uncertainty will always
be as large as half of the least significant digit in your measured value. For example, if you
and you lab partner both measure the mass of an object to be 123 g on a scale, then because
you are only reading a value to the nearest gram if the actual mass were as low as 122.5 g or
as high as 123.5 g your scale would still read it as 123 g so your uncertainty is ±0.5 g even
though you both measured the same value.

When using any measurement device the measurement uncertainty cannot be less than half
of the smallest scale increment (i.e. on a meter stick with tick marks every mm, the uncer-
tainty cannot be less than 0.5 mm) regardless of how carefully the measurement is taken,
that is because all measurement devices have this inherent uncertainty. That being said it
is possible to make a careful measurement with an uncertainty larger than the minimum
increment on the scale of the measuring device. For example, if you were to measure the
circumference of a disk by wrapping a string around the disk, marking the length of the
string and then straightening it out to measure with a meter stick, you might find that the
string stretches when it is around the disk, making it difficult to ensure the same length
when it is straightened out. In this case you would have to estimate how much the string
stretches, and use that as your uncertainty. Again this can be checked by observing the
variation in repeated measurements.

Uncertainty in calculated quantities

While it is important to note the uncertainty in measured quantities, it is also necessary
to use those values to determine how much uncertainty there is in any quantity calculated
from those measurements. There are two basic premises that govern how the uncertainty in
measured quantities affects the uncertainty in any calculated quantity, the first is that for
a function f(a, b, c, . . .) the uncertainty in the function f caused by the uncertainty in the
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measured quantity a is given by

δfa =

(
∂f

∂a

)
δa,

with similar expressions for the uncertainty due to b, c, etc. The second premise is that if
the measured values a, b, c, etc. are uncorrelated the uncertainty in f from each adds in
quadrature as follows

(δf)2 = (δfa)
2 + (δfb)

2 + (δfc)
2 + . . .

Uncertainties are uncorrelated when they are completely independent of each other. For
example if you measure the mass and acceleration of an object to determine the force on
it, your measurement of mass should have an uncertainty that has nothing to do with the
uncertainty in your measurement on acceleration. An example of correlated uncertainties
would be if you measured the radius of a circle and then doubled that to get a value of
diameter that you consider a “measured” value - any error in the measurement of the radius
would then produce the same relative error in the recorded value for the diameter, so these
uncertainties are correlated.

When the above two premises are applied to functions that involve the sum or difference
of two or more quantities, such as f(a, b, . . .) = a + b + . . . or f(a, b, . . .) = a− b− . . . the
resulting uncertainty in f due to each term is found from

δfa =
df

da
δa

δfb =
df

db
δb

where for f(a, b, . . .) = a± b+ . . . and df
da

= df
db

= ±1 with the sign depending on if b is being
added or subtracted. This gives δfa = δa and δfb = ±δb. When adding these uncorrelated
uncertainties using (δf)2 = (δfa)

2 + (δfb)
2 + . . . we get the general expression

(δf)2 = (δa)2 + (δb)2 + . . . (B.1)

Sum and difference formula for uncertainty

If the function g(a, b, . . .) = a× b× . . . or g(a, b, . . .) = a/b . . . is the product or quotient of
two or more quantities the resulting uncertainty in g is found from

δga =
dg

da
δa

δgb =
dg

db
δb
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where for g(a, b) = ab and dg
da
b, dg

db
= a. This gives δga = bδa and δgb = aδb. When adding

these uncorrelated uncertainties using (δg)2 = (δga)
2 + (δgb)

2 we get

(δg)2 = (bδa)2 + (aδb)2

dividing on the left by g2 and on the right by (ab)2 (which we can do since g = ab and
generalizing for more factors gives the general expression(

δg

g

)2

=

(
δa

a

)2

+

(
δb

b

)2

+ . . . (B.2)

Product and quotient formula for uncertainty

If formula 2.1 is applied to the N measurements of the same quantity a, each with identical
uncertainty δa, the uncertainty in the average of those N results, ā,is reduced according to

δā =
δa√
N

(B.3)

Formula for uncertainty in an average

Note that the above expressions do not give the uncertainty δf directly, but rather are
written in a way that is easier to remember but requires that you solve the expressions for
δf to determine the uncertainty that you will quote in the calculated quantity. These rules
can be applied in turn on more complicated functions. For example the uncertainty in a
function that involves both the sum and product of measured quantities h(a, b, c) = a× b+ c
can be determined by first finding the uncertainty in the individual components, i.e. find
δg(a, b) for g(a, b) = a× b using formula (2) and then rewrite h as h(g, c) = g + c and apply
formula (1).

Interpretation of results with uncertainty

Often times the purpose of lab experiments is to experimentally confirm the value of a
“known” quantity (such as the acceleration due to gravity) or to compare a quantity that
is measured in two different ways (for example the speed a bullet leaves a gun based on
a measurement of its trajectory as well as a measurement of its ability to displace a large
mass). When comparing two quantities that each have uncertainty (if one of the quantities
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is “known” that means the uncertainty is negligible) we can say the measured values “agree”
if the range of values for the two measurements overlap, that is if there is one possible value
that falls within the uncertainty of both measurements. Thus if we compare a quantity a±δa
to another quantity A± δA we say they agree if |a−A| < δa+ δA (i.e. the quantities differ
by less than the total uncertainty, so they could be a measure of the same value.

When the above criteria is not met, i.e. |a − A| > δa + δA the measurements “do not
agree” within the experimental uncertainty. It is useful to describe how much disagreement
there is, one meaningful way of doing this is to state how far they were apart relative to the
uncertainty

relative error =
|a− A|
δa+ δA

σ,

where σ is the greek letter sigma and stands for “standard deviation”. We can think of it
as just our unit of relative uncertainty just as the percent sign is our unit of percent error.
For example if two measurements have a difference that is twice the total uncertainty we
would say the measurements differed by 2σ. Another method is to describe the percent error
between the values

percent error =
|a− A|

(a+ A)/2
× 100%

and also express the total uncertainty as a percentage for comparison

percent uncertainty =
δa+ δA

(a+ A)/2
× 100%

These types of objective statements about the measurement and uncertainty are an important
part of a report. Subjective statements such as “the measured value was 0.2% off form the
expected value so the measurement was successful” are not useful and often lead to incorrect
conclusions - without knowledge of the uncertainty it is impossible to tell if an error is
significant, even if it seems small. Scientific reports have no room for subjective interpretation
of what is significant and what is not. With the tools for error analysis presented here there
is no reason for such subjective statements.

103



APPENDIX B. AN INTRODUCTION TO ERROR ANALYSIS

104



Appendix C

Logger Pro Tutorial

Many of the experiments in this manual rely on the LabQuest Data Logger to collect data
and on Logger Pro to analyze the data. You can find a quick reference manual online
at http://www2.vernier.com/manuals/LP3QuickRefManual.pdf, and you can download
Logger Pro for use on your own computer at http://tinyurl.com/sjsuLP (you will need
to authenticate via your SJSUone account - you need to sign out of gmail before you can do
this.). The instructions below represent just the most common steps you will be asked to
do.

Importing data

1. Click on the data logger device to start recording data and begin to move the
force sensor in and out to raise and lower the mass for 10 seconds while the LabQuest
data logger collects force and acceleration data. Do not let the mass touch the floor at
any point during the data collection.

2. Transfer the collected data onto one of the lab computers for analysis by connecting
it via a USB cable and opening “Data Logger Pro” on the computer. The device will
be auto-detected and you will be prompted to import the data. If you are successful
you can skip step 3k, otherwise see the instructions for manually importing data in the
next step.

3. If your data did not import automatically, save your data on the handheld device by
selecting “save” from the “file” menu. Then when it is connected to the computer,
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select “LabQuest Browser” from Logger Pro’s “File” menu and select the file that you
just saved.

Entering Data

Data can be classified in two forms: constants and variables, constant values (such as the
mass of an object) are called “User Parameters” in Logger Pro, while variables are called
“Columns” because the values the variable takes are organized as cells in a column of the
data table.

1. To enter a constant into Logger Pro select “User parameters. . .” from the “Data” menu,
and add a parameter giving it an appropriate name and recording the numerical value.

2. To manually enter the values for a variable click ‘New manual column. . .” from the
“Data” menu. Enter an appropriate name (and short name). You can have Logger
Pro populate each cell with a preset numerical value by clicking the “Generate Val-
ues” checkbox and entering the appropriate parameters, or you can simply type the
numerical values into the cells in the column after the column is created.

3. To calculate a quantity based on a variable you will create a new column for the
quantity. Select “New calculated column. . .” from the “Data” menu. Give the new
column an appropriate name (in both the “Name:” field and the “Short Name:” field).
In the equation panel create an expression for this column of the form that you wish
to calculate. For instance if you wanted to calculate the value x = r cos θ where r is a
constant and θ is a variable recorded in another column, you would select “r” from the
the “parameters” drop don menu, then type “*” to represent multiplication, then you
would select “cos” from the “functions” drop down menu (it is in the “trigonometric”
submenu - alternatively you could type “cos()” directly). Finally you would place your
cursor inside the parenthesis of the cosine function and select the appropriate column
name that represents θ from the “variables (columns)” drop down menu.

Graphing Data

When you begin using logger pro a graph is automatically generated for each of the initial
columns. If you need to change the quantities plotted it may be easiest to change the default
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graphs rather than to create new graphs from scratch, if this is the case you can skip step 3a
below

1. To create a graph from scratch select “Graph” from the “Insert” menu and then cus-
tomize it as described below.

2. To change the quantities plotted on a graph click on the label for the x or y axis and
select the new quantity you wish to plot. If you want to plot more than one quantity,
click on the y-axis and select “More”, then click the checkbox for every quantity you
want to include on the plot.

3. To change the appearance of the graph double click on the graph to bring up the
graph/axes options window. You might choose to turn off connecting lines or show
error bars from the “graph options” tab, or you might choose to change the scale of
the axes from the “axes options” tab.

Curve Fitting

While we often want to fit a particular function to the data on our graph and can do so
through the “curve fit. . .” option of the “Analyze” menu, when we want to fit a straight line
to the data we can use the short cut of selecting “linear fit” instead.

1. When fitting a general curve you will first have to choose the form of the function from
the “General Equation” pane. You can then manually enter parameters that you wish
to use for the fit or you can click “Try Fit” to have logger pro select the parameters
that gives the best fit.

2. Once the best fit curve is drawn on the graph a box appears showing the fit parameters.
You can double click on the box to bring up a menu that lets you select how the
fit parameters are presented, including whether to show the uncertainty of the fit
parameters.

3. By clicking and dragging on the brackets that appear around the data you can select
a limited portion of the data to use in the curve fit. This could be useful for example
if you had some outlying data poitns at the beginning or end of your data set that you
did not want to influence the fitting routine.
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Expressing Uncertainty

We can express the uncertainty in our data points by including error bars on the plot. These
vertical and/or horizontal bars around the data points represent the range of y and/or x val-
ues respectively that are within the experimental uncertainty associated with the measured
data point. To include these we need to tell Logger Pro how big our errors are and then
make sure it is set to show error bars on the plot

1. Click on the heading of the column that you wish to enter the uncertainty for. In the
“Options” tab, check the “error bar calculations” box. You can enter a fixed error
value, a percentage, or you can point it to a column that holds the error values for
each point.

2. Double click on the graph to bring up the graph options window and turn on the option
to show the x and y error bars.
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